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Micro Focus Enterprise Developer 9.0 for
Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any documentation updates.

Product Overview

Enterprise Developer enables you to develop COBOL applications within Microsoft Visual Studio. You use
the Visual Studio integrated development environment (IDE) to edit, compile and debug COBOL
applications. The IDE provides all the functionality to manage projects and build applications.

You can develop applications that have been migrated from the mainframe and that use mainframe
technologies like CICS, JCL, and IMS. These compile to native COBOL code, as .exe or .dll. You then
deploy and further debug the application under Enterprise Server.

The product is available in the following variants - Enterprise Developer for Visual Studio 2022. The
execution environment for applications created with any of these product variants is Enterprise Server.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Enterprise Developer can automatically relink the existing executable or .dll to the new version of
the C run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.
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What's New
This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

• Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

• Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.

• Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

• Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 9.0 release.

Enhancements are available in the following areas:

• Learn Micro Focus™ Learn COBOL extension and Micro Focus™ COBOL Fundamentals Course
• Micro Focus Enterprise Extension for Visual Studio Code
• Micro Focus COBOL Extension for Visual Studio Code
• .NET Support
• COBOL Language
• Compiler Directives
• Data Modernization Advice
• Debugging
• Enterprise Server
• Enterprise Server Common Web Administration (ESCWA)
• Enterprise Server Security
• HCO for PostgreSQL
• IMS support
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Micro Focus Unit Testing Framework
• OpenESQL
• PL/I Support
• Terminal Emulation
• Tracing
• Visual Studio Integration

Learn Micro Focus™ COBOL Extension for Visual Studio
Code and Micro Focus™ COBOL Fundamentals Course

Back to Top

6 | What's New



Micro Focus has released a new video-based training course in COBOL, Micro Focus™ COBOL
Fundamentals Course. The course teaches the fundamentals of the COBOL language, introduces the
Micro Focus™ COBOL syntax, and usage of Micro Focus COBOL tools.

The course is ideal for developers familiar with C, Java, or .NET who want to learn COBOL. It doesn't
matter what language you know, as long as you have experience of standard programming concepts, this
course is for you.

A new Learn Micro Focus™ COBOL Extension for Visual Studio Code is available. The extension comes
with the training materials for the COBOL training course. For information about the COBOL course, and
the Learn Micro Focus™ COBOL Extension for Visual Studio Code, visit www.cobol.com.

Note: This extension is not included with the Enterprise Developer installer.

Micro Focus™ Enterprise Extension for Visual Studio
Code

Back to Top

The following features are now available in the Micro Focus™ Enterprise Extension for Visual Studio Code
when you use it with Enterprise Developer 9.0:

• A PL/I Language Server is available. This enables the following advanced features in the PL/I editor -
Find All References, Peek, Outline view, collapsible regions, Rename, Navigate To, background error
reporting, variable highlights.

• A new button, , Debug PL/I Program or Run PL/I Program in the top right corner of the editor, is
present for the current PL/I program.

• You can now specify the PL/I main file context for include files if an include copybooks is referenced in
more than one program.

Note:

• This extension is not included with the Enterprise Developer installer.
• This extensions also installs the Micro Focus™ COBOL Extension for Visual Studio Code.

Micro Focus™ COBOL Extension for Visual Studio Code
Back to Top

The following features are now available in the Micro Focus™ COBOL Extension for Visual Studio Code
when you use it with Enterprise Developer 9.0:

• JVM COBOL debugging
• COBOL notebooks where you can have text and executable blocks of COBOL code in the same file.
• Colorization for COBOL directives files, cobol.dir.
• A new button, , Debug COBOL Program or Run COBOL Program in the top right corner of the

editor, present for the current COBOL program.
• Configuration setting for custom tab stops.
• A Micro Focus COBOL terminal in the TERMINAL pane.
• You can now specify the COBOL main file context for copybooks if a copybooks is referenced in more

than one program.

Note: This extension is not included with the Enterprise Developer installer.
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.NET Support
Back to Top

This release provides the following enhancements to .NET support:

• This release installs several NuGet packages each of which contains the assemblies for a specific Micro
Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0 are linked to a
core package, MicroFocus.COBOL.Runtime.Core, that includes the basic functionality for the projects.
You need to add any additional packages (such as a specific file handler, COBOL Accept/Display etc.)
manually to the projects. The new packages enable better granularity of distributions, and provide more
flexibility and control over what is packaged with the application.

• New SDK version - the Micro Focus SDK version has changed to version 2.1. See Upgrading
existing .NET COBOL project files in your product Help for details on how to upgrade your existing
projects.

COBOL Language
Back to Top

This release provides the following new features and enhancements to the COBOL language:

• Double-colon, ::, qualification is now available as a qualifier for data names and when dereferencing
pointers.

• PERFORM frame local variables - variables that are DECLAREd are now properly scoped. Reentering
the SECTION, whether recursively or after leaving, gives a new instance of such variables. This
provides better locality of data, and helps with writing of better structured code.

• Parameterized sections - syntax that allows program sections to accept arguments and return values.

• PERFORM of a SECTION can now pass arguments to that SECTION.
• A result can be returned to the code that PERFORMed the SECTION.
• Sections that return a value can be used as functions, in contexts where an identifier is expected.

• Compiler can identify platform at compile time - the compile-time constants __unix, __windows,
__dotnet, __jvm, and __native have been introduced. These can be tested in $if statements to
tailor code to the platform being used.

• Enhanced CBL_STRING_CONVERT library routine - CBL_STRING_CONVERT can now convert
strings to and from Base64.

The following enhancements add further support for the IBM Enterprise COBOL version 6.4:

• User-defined functions - user-defined functions are now available in an Enterprise COBOL dialect for
version 6.4 compatibility. Reference the product Help, General Reference > COBOL Language
Reference > Part 3. Additional Topics > Additional Dialect Support > Enterprise COBOL Syntax Support
> User-Defined Functions under ENTCOBOL dialect. A new Compiler directive, MANAGED-FNC-
PARAM-BY, enables you to specify whether the managed behavior of numeric function parameters
should default to BY VALUE or BY REFERENCE.

• Enhanced mechanism for interoperation between Java and COBOL - The COBOL and Java
interoperability has been enhanced to extend the capabilities of your COBOL applications with Java. It
removes the need to write object-oriented (OO) COBOL, as your native COBOL and Java programs can
now interoperate in the following scenarios:

• COBOL programs can be marked as JAVA-CALLABLE, meaning that they can be called from Java
as though they were Java static methods.

• COBOL program can call Java static methods using the java.class.method call.
• COBOL data can be shared with Java programs by marking it as JAVA-SHAREABLE.
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• Comprehensive support for automatic conversion between a wide variety of popular Java data types
and their corresponding COBOL types so that parameter passing and returned value handling require
no special processing in user code.

Compiler Directives
Back to Top

This release provides the following enhancements.

A new mechanism for setting Compiler directives (Technology Preview):

• Common directives files - this release introduces common directives files, directives.mf files, that
enable you to automatically provide all required directives needed to compile multiple and Mainframe
Subsystem applications without having to specify the directives individually. This feature is not available
for Assembler or IMS.

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use
and it is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will
be delivered at a GA level and if it is, then the functionality provided might differ considerably from
this technology preview.

New Compiler directives:

• ALPHA-LIT-CONT - determines whether the right margin or the end-of-line is used to delimit the
continuation of a non-numeric literal.

• DECLARE - defines the behavior of locally declared variables.
• ILEXPOSEALPHA/ILEXPOSEGROUP - these two directives can expose alphanumeric or group items

passed by value to parameterized sections or methods in .NET COBOL programs as byte arrays (the
default is to expose as string objects).

• ILSTRINGLOAD - where .NET COBOL programs with a very large number of distinct alphanumeric
literals cause internal limits to be exceeded, use this directive to create these literals in a backing file,
which can then be converted to strings at run time.

• MANAGED-FNC-PARAM-BY - determines whether user-defined function parameters are passed BY
VALUE or BY REFERENCE by default when compiled with ILGEN.

• INITIAL - determines how Working-Storage is initialized for programs marked as IS INITIAL.

A family of new Compiler directives has been introduced to support the new mechanism for interoperation
between Java and native COBOL:

• JAVA-SHAREABLE - use the JAVA-SHAREABLE ON and JAVA-SHAREABLE OFF directives to bracket
one or more WORKING-STORAGE data items to indicate that they are to be made read and write
accessible from Java applications interoperating with this COBOL program.

• JAVA-CALLABLE - instructs the Compiler to make the COBOL program automatically callable from
Java.

• JAVA-GEN-PROGS, JAVA-GEN-STRG, JAVA-OUTPUT-PATH, and JAVA-PACKAGE-NAME - control the
behavior of COBOL programs that interoperate with Java through the JAVA-CALLABLE or JAVA-
SHAREABLE directives or by calling Java static methods using the CALL statement.

Data Modernization Advice
Back to Top

The product Help now includes advice on moving your COBOL data files, such as flat files, VSAM, indexed
or sequential files, etc. to a relational database (RDBMS). The documentation lists the solutions included in
Enterprise Developer that enable you to achieve this, including advice on the best option for your
application as well as performance considerations.
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Debugging
Back to Top

This release provides the following new feature:

• In Visual Studio, you can now debug .NET COBOL projects in WSL.

Enterprise Server
Back to Top

This release provides the following enhancements:

• A new casverify command-line utility is available. This utility enables you to verify the configuration of
a specified enterprise server region without attempting to start it, and also enables you to create
immediate diagnostics information in JSON or human-readable output. Verification stages are modular,
enabling you to specify which validation checks to run.

• You can now list job steps to enable users to perform advanced restarts. Job steps can be output to
JSON by specifying casout /%jnumber or output to a table by specifying casout /%tnumber. See
casout for more information.

• Enterprise Developer CICS now supports the MAPPINGDEV option of SEND MAP and RECEIVE MAP
commands.

• Application diagnostic reporting now enables you to collect JCL process failures. See Application
Diagnostic Reporting for Enterprise Server for more information.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

Enhancements are available in the following areas:

• Accessibility improvements - provide improved compliance with 508 and WCAG 2.1 standards.
• API, version 2 extensions - includes updated versions of some of the existing API version 1 endpoints,

and has been extended to contain more endpoints.
• Merged Archived Spool - you can now configure an enterprise server region to view a merged archived

spool in the UI. You can view multiple archived spools from a single region, and view old spool
information for multiple jobs that have ran under a previous name

• Page search facility - you can now search for a page that contains a specified search string. This
enhancement is part of the WCAG 2.1 requirements for accessibility.

• PAC clients - the ESCWA UI lists all TN3270 clients connected to a PAC. This enables you to administer
and monitor clients across the entire PAC from a single PAC region.

• TLS-enabled Redis connections. ESCWA now supports administering and monitoring PACs with a TLS
Redis SOR.

Enterprise Server Security
Back to Top

This release provides the following new features and enhancements:

• Demo CA - the component has been completely redesigned and is now included as part of Enterprise
Developer. Demo CA supports multiple installations, uses up-to-date cryptographic support, and

10 | What's New



generates modern version 3 certificates with SANS, PKIDs, AKIDs, etc. signed by an intermediate CA.
Demo CA is now easier to use and has improved interoperability with third-party SSL/TLS systems.

Note: Micro Focus strongly recommends that Demo CA is only used for SSL/TLS development
and testing and is not intended for use in a production environment.

• esfupdate support for the Vault Facility - the esfupdate utility now supports the use of the Vault
Facility for credentials it needs to connect to MFDS.

• OpenSSL 3.0 - OpenSSL has been updated to use the current Long Term Supported OpenSSL
cryptographic library.

• VSAM External Security Manager (EAP) - the VSAM ESM Module is a new option for Enterprise Server
security which is simpler and more convenient than using LDAP-based security. The VSAM ESM
Module provides a security manager for Enterprise Server which keeps security data in COBOL data
(VSAM) files. It provides many of the features of the MLDAP ESM Module but does not require an LDAP
server or other third-party solution. Security data can be imported from a YAML file, facilitating the
securing of Enterprise Server and the modification of its security data.

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

HCO for SQL Server
Back to Top

This release includes support for the following:

• The Define Lists tool in the HCOSS UI has been enhanced to enable you to select a dependency mode
to use when creating a transfer list. The available modes are:

Default Automatically include all parent objects of the selected object.

Family tree Automatically include all parent objects of the selected table.

Automatically include the child objects of each parent object.

Repeat until no more parents and children are found.

No dependency handling Include the selected table only (do not include any parent or child objects).

• The Transfer Data Tool now includes the start and end date and time for each table transfer.

HCO for PostgreSQL
Back to Top

This release includes support for the following:

• PostgreSQL Global Development Group (GDG) community edition and Amazon AWS via new options
for the TARGETDB directive.

• Migration of z/OS DB2 COBOL programs to PostgreSQL GDG community edition.

Attention: Support for PostgreSQL Global Development Group (GDG) community edition is in Early
Adopter Program (EAP) release status. We intend to provide the finalized feature in a future release.
Please contact Micro Focus Customer Care if you require further clarification.

IMS Support
Back to Top
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This release includes the following new features for IMS:

• A new environment variable, ES_IMS_DISPLAY_NEW, has been added to enable the new z/OS /
DISPLAY timestamp output format.

• APARM handling has been updated to use EBCDIC APARMs obtained from EBCDIC applications. In
addition, the APARM positional parameter for DLI has been changed from 19 to 20 to be consistent with
the IBM IMS documentation. The APARM positional parameter for BMP applications remains at 19. 

• The ES_IMS_APARM_DLI environment variable has been added to enable the APARM handing
behavior of previous releases. See ES_IMS_APARM_DLI for details. 

Interface Mapping Toolkit
Back to Top

This release provides the following enhancements:

• YAML support is now available for COBOL client generation. OpenAPI schemas can now be in YAML, in
addition to JSON format.

• The Interface Mapper user interface for COBOL program-based service interfaces has been updated.
The Interface Fields pane available in earlier versions is now represented by two panes — Interface
Fields - Input and Interface Fields - Output. The COBOL Entry Points pane is situated between
these two new panes. The relationships between COBOL entry points and corresponding interface,
COBOL assignment, and reusable fields are depicted visually using arrows. The panes can be
repositioned for easier viewing of arrow relationships.

JCL Support
Back to Top

• In this release the security around running programs from JCL jobs has been enhanced to enable you
to limit:

• The location of the programs to load
• Permission to run particular programs based on user ID

This release writes several additional messages to the job log as a JCL job runs, including the location
from which each program is loaded. For example:

JCLCM0303I Program IDCAMS (MFJAMS) loaded from library
SYS1.LOADLIB

When running one of your own programs, you might see messages such as:

JCLCM0305I Failed to find program JCLREAD in private libraries
and SYS1.LNKLIB.
JCLCM0306I Number of SYS1.LNKLIB entries: 0.
JCLCM0303I Program JCLREAD loaded from library SYS2.LOADLIB.

Combined, these three messages indicate that the program was not found in the main program search
path (SYS1.LNKLIB) but has been loaded from the JES Program Path (SYS2.LOADLIB).

For more information about increased JCL security checks including a configuration example, see JCL
Enhanced Security Checks in your product Help. For information about suppressing security check
messages in the job log, see ES_JES_HIGHER_SECURITY_LEVEL, also in your product Help.

• The MF_SPLJNO_LOCK environment variable has been added. Using this variable, you can change
the process by which the JES engine accesses the job number of a JCL submission to enable
enqueuing, which can increase throughput, reduce latency, and reduce disk/file access. For details, see
MF_SPLJNO_LOCK. 
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Mainframe Access
Back to Top

This release includes the following new features for:

• Mfdaemon vault usage - the Mfdaemon persistent stored secrets are now stored in the vault.
• TAUZCAPP master configuration file location from JCL - MFA Server now enables you to specify the

location for the master configuration file, required by TAUZCAPP, to be performed via JCL instead of
having to edit a REXX script.

Micro Focus Unit Testing Framework
Back to Top

The Micro Focus Unit Test Seam pre-processor (mfupp) has been enhanced to aid the creation of self-
contained unit tests that contain EXEC CICS or EXEC SQL statements. These EXEC statements can be
removed or mocked depending on the requirement of the test case.

The Micro Focus Unit Test Runner has also been enhanced to aid the development of these styles of unit
tests by the addition of new code generation arguments available from the command-line interface.

OpenESQL
Back to Top

In this release, OpenESQL applications now support z/OS DB2 syntax for the community version of
PostgreSQL provided by the Global Development Group (GDG).

PL/I
Back to Top

This release includes enhancements in the following areas:

Open PL/I Compiler:

The following enhancements make the migration of existing applications to new platforms easier. They also
provide an improved functionality when using Open PL/I to develop z/OS applications.

• The QUICKSORT and QUICKSORTX built-in functions are now supported.
• Restricted expression evaluation now also takes place on AUTOMATIC, DEFINED, and BASED

declarations in addition to STATIC which was added previously.
• Support is available for the XMLCONTENT attribute.
• The use of the RELEASE statement now implies OPTIONS(FETCHABLE).
• Improvements have been made to the support for factored lists used in the INIT attribute of a variable

declaration.
• DEFAULT RANGE(*) with no attributes no longer causes the compiler to abort.
• Support is available for the FIXEDOVERFLOW condition.
• Support is available for the FOFLONASGN, FOFLONDIV, FOFLONMULT, FORCEODD Fixed Decimal

behaviors.
• Support is available for validation of FIXED DECIMAL data.
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• Support has been added for more than 2GB of static data in a single procedure.
• Support has been added for placing uninitialized static data in the .BSS section.
• Improved diagnostics when passing an array to a procedure which expects an array with differing

attributes.
• Improved diagnostics when passing CONTROLLED variables as parameters and attributes are in

conflict.
• PL/I FETCH xxxx SET() syntax supports setting a PL/I ENTRY LIMITED.

Open PL/I Debugger:

• Performance improvements on the display of arrays and complex structures.
• Support for arrays declared with negative array bounds.
• Improved debugger performance when watchpoints are set but not active.
• Improved breakpoint clean-up and handling in-between debugger sessions under Enterprise Server.
• Added a message to PLIDUMP to print {cond static external} for CONDITION declarations in the locals

section rather than printing a generic "variable not found" message.
• Added support for decorated symbol/variable names in PLIDUMP on Windows.
• New watch points are now honored after a CONVERSION condition was raised.
• Remote debugging is supported on Solaris (SPARC).

Open PL/I EXEC Preprocessor:

• It is now possible to specify DB2 LUW OPT guidelines within static SQL.
• The stability of CICS API calls on 64 Bit Solaris (SPARC) has been improved.

Open PL/I Macro Preprocessor:

• The COMMENT built-in function now supports comments larger than 100 bytes in length.
• The -tagmin preprocessor option supports skipping of %SDEBUG; and %RDEBUG; statements when

the replacement text fits on the same line as the macro invocation without wrapping.
• The conditional statements processing has been improved.

Open PL/I Language

Note: These features are in Early Adopter Program (EAP) release status. We intend to provide the
finalized features in a future release. Please contact Micro Focus Customer Care if you require further
clarification.

• Open PL/I now supports ordinals via the DEFINE ORDINAL statement, the ORDINAL attribute for the
DECLARE statement, and the ORDINALNAME, ORDINALPRED, and ORDINALSUCC built-in
functions.

• The DO statement now supports UPTHRU and DOWNTHRU.

Open PL/I Run-Time System:

The following enhancements are available:

• Support for more than 2GB of static data in a single procedure.
• Support for placing uninitialized static data in the .BSS section.
• JSONPUTMEMBER now supports quotation marks within its input.
• Support for the XMLCONTENT attribute.
• The PL/I Run-Time System optionally provides the ability for ERROR to be driven in place of

STRINGRANGE and SUBSCRIPTRANGE.
• PLIDUMP display of the offset within prologue code a signal is received within the prologue of a PL/I

procedure.
• Support for FIXEDOVERFLOW condition.
• Support for FOFLONASGN, FOFLONDIV, FOFLONMULT, FORCEODD Fixed Decimal Behaviors.
• Support for validation of FIXED DECIMAL data.
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• The speed for FIXED DECIMAL operations has been improved.
• The stability of CICS API calls on 64 Bit Solaris (SPARC) has been improved.

Product Help:

• The product Help includes a new section on Open PL/I Conditions.
• A new section, Open PL/I Problem Determination is available. Reference this section to learn how to

mitigate execution, link, and debugger problems, how to use PLIDUMP to resolve issues, and also to
learn about specific PL/I-related information pertaining to the use of the Consolidated Tracing Facility.
This new documentation also includes a list of data items you need to collect before raising a PL/I
problem with Micro Focus Customer Care.

Terminal Emulation
Back to Top

This release provides the following new features.

• Enterprise Developer and Enterprise Server now incorporate Host Access for the Cloud (HACloud) to
provide 3270 emulation. HACloud is the leading Web-based emulator and requires no additional
desktop installation. HACloud replaces the Rumba+ Desktop emulator previously supplied with
Enterprise Developer. Customers that have Rumba+ Desktop entitlement can continue to use it within
Rumba+ Desktop.

• In this release, Host Access for the Cloud supports session configuration options, as well as creating
and using macros.

• IDE support for Micro Focus Reflection Desktop - you can now select Reflection Desktop as the default
TN3270 display to open from the IDE when you run or debug your TN3270 applications. You can now
play Reflection or Rumba+ Desktop macros with Reflection Desktop.

Tracing
Back to Top

This release provides the following enhancements and new features:

• Improvements have been made to the to the Common Communications Interface (CCI) tracing. CCI
tracing can now be enabled using only the Consolidated Trace Facility (CTF) configuration, without
needing to set trace options in CCI.INI or the environment as well. SSL/TLS trace points have been
added to the CCI CTF trace, making it easier to control. It uses the same mechanism as other
components such as the COBOL RTS. SSL/TLS tracing is now incorporated into CTF, placing all
communications trace output in one place and adding timestamps and other useful information to these
tracepoints. See Enabling CCI Tracing for more information.

Visual Studio
Back to Top

This release provides the following new features:

• Converting JSON data to COBOL classes - you can now copy JSON data and use the Paste JSON As
Classes command to copy it into a .NET COBOL file. This generates COBOL classes that enable you
to deserialize the data in those classes.

• Document Outline window for COBOL files.
• Editor support is available for local variables and parameterized sections.
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• Format with code cleanup can now be configured to change any keywords in your code to lowercase or
uppercase.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• .NET Support
• Compiler
• Data Tools
• Documentation
• Enterprise Server
• File Handling
• HA Cloud
• IMS Support
• JCL Support
• Micro Focus Directory Server
• PL/I Support
• Runtime System
• Setup Issues (Windows)
• Visual Studio IDE

.NET Support

Back to the list

• The 9.0 release installs several .NET 6 NuGet packages each of which contains the assemblies for a
specific Micro Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0
are linked to a core package, MicroFocus.COBOL.Runtime.Core, that includes the basic
functionality for the projects. You need to add any additional packages (such as a specific file handler,
COBOL Accept/Display etc.) manually to the projects.

Building existing .NET COBOL projects created prior to 9.0 might result in build errors. You can ensure
compatibility by enabling the use of the MicroFocus.COBOL.Runtime metapackage. Alternatively,
you need to add any required NuGet packages manually to the older projects.

See Upgrading existing .NET COBOL project files in the product Help for details on how to upgrade.

Compiler

Back to the list

• Preprocessor options of more than 256 bytes are now supported, and no longer cause the Compiler to
crash.

02289875 02308713 (272069)

Data Tools

Back to the list

• A new print function available from the File group and the File menu enables you to print the records
shown in the editor.

00367084 (12432)
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• An enhancement to the Compare Files function has been added, so that when a comparison is made,
the File Information option shows a statistics overview of the comparison being displayed.

02200177 (222157)
• In the Data File Editor, the Compare Files function has been enhanced to allow you to select start and

end columns in which to compare, so only a subset of a record is compared, rather than the entire
record.

02306654 (222159)
• A Quick final page access option has been added to the Preferences dialog box of the Data File

Editor. When selected, large variable sequential files (files > 10,000 records) immediately jump to the
last page of the file when it is opened.

02330923 02365033 02399254 (294002)

Documentation

Back to the list

• To correct an error that sometimes occurred when generating IMTK clients, you must install the latest
version of the Visual Studio MSVS Workload > C++ x64/x86 component. 

(400031)
• When using the cob command to link PL/I programs targeting Enterprise Server, you must include the -

lmfpdfpz parameter in your link command to avoid problems in multi-step jobs. 

02451241 (386064)
• FIXEDOVERFLOW conditions are now implemented and will occur when detected.

02163371 (203207)

Enterprise Server

Back to the list

• A new option to uninstall a PAC installed on an enterprise server region before deleting the region has
been added to ensure that all PAC components are properly removed.

01907370 (124107)
• ESCWA now validates the TLS properties to help prevent errors on entry.

Note: If ESCWA has an invalid TLS configuration, it reverts to starting without TLS enabled.

01983736 (203178)
• In ESCWA, a Stop for IMS MPRs, JES Initiators, and JES Printers now operates correctly.

02311796 (286178)
• An issue with not being able to update or navigate the ESCWA UO though the job output in the spool

while it is still running has been resolved.

02322494 (286142)
• In ESCWA, the default dashboard can now be modified for all users of a server.

02458710 (392040)
• In ESCWA, the FCT Fix Up button has been added to the Active FCT page. See Active FCT in your

product Help for more information.

(374021)
• The Job View page in ESCWA now includes a list of job steps that have run during the current

enterprise server region up time.

(347033)
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• A new configuration property has been added to ESCWA to enable the default language the UI displays
to be overridden from the user's browser locale.

02227239 02307446 (260128)
• ESCWA now supports TLS enabled Redis repositories.

(306097)
• In ESCWA, the Process ID column has been added to the table on the Dynamic Debug page. See

Dynamic Debug in your product Help for more information.

(350029)
• In ESCWA, the Spool page can now display multiple Spool Output types.

02503214 (401184)
• ESCWA now supports Expiration Dates for Catalog DCB.

02159515 (202201)
• In ESCWA, a new PAC Client List page has been added. This page displays a list of PAC members

and associated information. See PAC Client List in your product Help for more information.

(384037)
• ESCWA now supports merged archive spool. See Spool in your product Help for more information.

(245050)
• An alternate index has been added to the non-recoverable temporary storage file TXTSNR. This is to

enable queues to be returned in alphabetical order when browsing with INQUIRE. When warm starting
non-recoverable TS, if TXTSNR has only a single key then the file will automatically be upgraded to
include the alternate index. If there is a problem during the upgrade process then message CASI1405S
will be written to the console indicating the failure and that the enterprise server region will fail to start.
In this case, the file will either need to be repaired or temporary storage will need to be cold started.

Note: Once TXTSNR has been upgraded it can no longer be used on an older version of the
product that does not contain this fix.

02441509 (389045)
• Corrected the spelling for the db_server_name Configuration Manager property. You will need to

update existing 8.0 enterprise server region configurations by either applying any change on the
ESCWA General >Advanced page, or by updating the mfConfigManagerData MFDS property
through the ESCWA API. If this is not performed, the warning message CASCF0071W
Configuration Manager - The requested property (db_sever_name) was not found
will be displayed in the Console log during region initialization. This will not cause any issues if the
Region Database Server Name property was not previously used, or if it was set though the
ES_DB_SERVER environment variable. Otherwise, you will need to reset this property using the above
methods as the previous configuration for Region Database Server Name will not be honored, which
might result in the region failing initialization.

(350050)
• A recent change resulted in EXEC CICS TIME(...) expiring immediately. This has been fixed.

02525957 (411120)
• In the context of a multi-hop Distributed Program Linking (DPL), if the last stage used the default mirror

transaction, its back-end could be left hanging if a SYNCPOINT was invoked by the upstream partner.
This has been fixed.

02432614 02434318 (377071)
• You can now list job steps to enable users to perform advanced restarts. Job steps can be outputted to

JSON by casout /%jnumber. Job steps can be output to a table by casout /%tnumber. See
casout in your product Help for more information.

(401023)
• When submitting JCL by content via ESCWA or the JCL command cassub, Enterprise Server will now

authorize the request against a new cassub.content resource class under OPERCMDS. If this class is
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not specified then Enterprise Server will revert to existing behavior. See Resource Classes for ESMAC
and Operator Command Security in your product Help for more information.A prototype definition has
been provided in the standard LDIF files shipped with the product.

(313048)
• A new parameter, -i has been added to the cassub utility. This parameter enables the user to specify a

correlator up to 32-bytes long comprised of ASCII printable characters. The JCL engine will ensure this
correlator has not previously been supplied for a JCL JOB. If a duplicate correlator is detected, the job
submission will be rejected and the previous JOB ID will be returned. See cassub in your product Help
for more information.

02462072 (394004)
• The Redis server supplied with the product is now version 6.2.6.In ESCWA, you must now specify the

Certificate Authority Filepath, Certificate Filepath, and Private Key Filepath properties on the
Advanced Region Properties page for all enterprise server regions that are members of a PAC that
has a TLS-enabled Redis Scale-Out Repository (SOR). See Scale-Out Repositories in your product
Help for more information.

00373756 (12618)
• When a CICS abend occurs, the 4 letter abend code now appears after the Transaction ID in HSF

records. There has been no change in behavior in the case of an RTS abend, where the transaction
name followed by ABEND still appears.

(246037)
• EXEC CICS INQUIRE TASK LIST now includes dispatchable (queued) tasks in the returned LISTSIZE

parameter.

(365089)
• When performing a DPL targeting a program that had an installed PPT specifying that it was remote,

the use of the TRANSID option on the LINK would be ignored. This has been fixed.

02434323 (386136)
• During XA recovery, if a resource manager reports an in doubt transaction which has no log entry, a

CASXO0040W message will now be displayed in the console.

(425081)
• If a SOR cannot be connected during enterprise server region start up, then the region no longer starts.

Previously, this only applied to the PSOR, but now applies to other SORs which were only used for TS
and TD queues. This change was made because the previous behavior could lead to queues being
written to different locations (SORs or disk) across the PAC. If a PSOR cannot be connected during a
process start up when the region is already running, then the process will be blocked until the
connection can be established. Retries will be attempted at increasingly longer intervals. If a (non-
PSOR) SOR cannot be connected to at process start up when the enterprise server region is already
running, then the process will continue to start up. At queue access time, for a queue that must go to
that SOR, the connection will be retried. If this is unsuccessful then the command will receive an
IOERR.

02399193 (356005)
• ESMAC is disabled by default. ESMAC can be enabled from the Advanced Region Properties page in

ESCWA.

(397027)

File Handling

Back to the list

• The SQL Server ENQ/DEQ implementation has been modified to eliminate any possibility of ENQ
request failures occurring due to an intermittent Service Broker problem. The new implementation
introduces a new ENQ stored procedure, and modification of the existing DEQ one to allow it to work
with both the Service Broker and non-Service Broker implementations.
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(285197)
• The OPEN EXTEND operation now follows the behavior expected from the OPEN statement as

documented.

02454638 (386087)
• ICETOOL emulation now supports the RESIZE operator.

(350035)

HA Cloud

Back to the list

• The default color scheme for HA Cloud in Enterprise Server has been updated to cyan on black.

(291041)
• The bundled Host Access for the Cloud (HACloud) Session Server has been updated to 2.7.0.6.

(375012)
• Micro Focus Host Access for the Cloud shipped with Enterprise Developer now offers session

customization options such as connection, and display options, and the functionality to record, and run
macros.

(392026)

IMS Support

Back to the list

• A problem that occurred when a restart call (XRST) referencing a checkpoint ID received checkpoint
data that originated from a different program when a shared checkpoint log file was used and the other
program issued the same checkpoint ID has been fixed.  IMS now requires that the name of the
program issuing the XRST must match the name of the program that issued the checkpoint.

(310065)
• The JES alias feature is now supported for IMS application main programs executed from JCL.

02356855 (308032)

JCL Support

Back to the list

• After the release of Enterprise Developer 7.0 PU17 and 8.0, the structure of the M_SPL_JOB.dat file
was updated. If you are upgrading to this release from a release that does not contain the update, you
must rebuild M_SPL_JOB.dat using the following command, and then replace M_SPLJOB.dat with
NEW_M_SPLJOB.dat before executing the merge spool job.rebuild
M_SPLJOB.dat,NEW_M_SPLJOB.dat /r:v344-604

02516141 (407126)
• When performing an IDCAMS REPRO on a cluster with the LIKE parameter set, if the LIKE cluster has

data or index references associated with it, then similar data and index references are now created for
the new cluster.

02358077 (363063)
• If an XA switch module failed while a DSNRLI program was using it then there was no way to

programmatically restart the switch module. This has been corrected. If a module fails with an TX_FAIL
error code (-7) the module can be reassociated with the unit of work by calling DSNRLI IDENTIFY. In
this case the check for the correct DSNRLI call ordering has been suspended so that IDENTIFY can be
called after an TX_FAIL error. The TX_FAIL return code will be passed back to the calling program so
that it is aware of the error. TX_FAIL is -7 and will replace the normal DSNRLI return code (8).

02364792 (323018)
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• System symbols, defined in SYS1.PARMLIB(IEASYM00) can now be filtered by use of the LPARNAME
entry. See INITSYS.JCL in the jcl-symbols examples.

(387029)
• Security for loading utility programs, either supplied by the user or any Micro Focus utilities, has been

increased. Users can now specify a number of libraries that hold program modules and who can use
them. See JCL Enhanced Security Checks in the product Help for more information.

PSEC:103014 (86177)
• When a dataset is required by MFFTP to be sent (put) or received (get), then MFFTP issues a dataset

lock that remains in effect until the end of the step. The location of the physical files used by MFFTP are
also validated against the PHYSFILE rules (if implemented). This access validation could cause security
errors if access is not allowed to the location of the FTP input and output file and might require that the
location be changed. This is usually the default allocation location, but may also be specified by
MFFTP_TEMP_DIR, or by adjusting the PHYSFILE rules to accommodate the location.

02210700 (244030)
• A step running IKJEFT01 was incorrectly returning the highest return code of all commands executed

instead of the return code of the last command executed. The MF_IKJEFT_KEEP_MAX has been
added to correct this problem. Its default setting is MF_IKJEFT_KEEP_MAX=N. However, if the new
behavior leads to a change in the COND CODE, and this is a problem for your application, you can
return to the original behavior by setting MF_IKJEFT_KEEP_MAX=Y.

02532126 (415094)
• When the return code from an IKJEFT step exceeded 4095 it could be incorrectly adjusted depending

on the IKJEFT program called. To remedy this, the return code when IKJEFT01 is called is changed to
12. Also, when IKJEFT1A or 1B is called, the return code is adjusted to RC modulo 4096.

02514544 (406145)
• DSNRLI return codes did not always correctly reflect the outcome of the SRRCMIT and SRRBACK

functions. This has been fixed.

(408001)
• When the result of a SRRCMIT or SRRBACK call was a MIXED status, meaning that some XA modules

committed or rolled back and some did not, then DSNRLI issue either commit or rollback upon
shutdown at the end of the step. This was incorrect. DSNRLI will not NOT issue commit or rollback at
step end. The XA Recovery processing maybe able to recover the 'in doubt' transaction.

02512717 (406089)
• MFFTP has been enhanced to pass relevant file transfer information for FTP operations such as PUT,

GET, and DEL, to a user exit defined by the new environment variable, MFFTPXIT. To enable the exit,
set MFFTPXIT to a user-exit program file, for example, the provided MFFTPXIT.cbl sample file. A list
of valid parameters is in the provided mfftpxit.cpy copybook. When the user exit is enabled and an
FTP step returns a non-zero code, a copy of the *.op FTP output file is created using the *.out
extension in either the defined MFALLOC_LOC or MFFTP_TEMP_DIR location. Use the *.out file to
determine the cause of FTP operation failures.

02287628 (259117)

Micro Focus Directory Server

Back to the list

• The External Security Manager (ESM) checks did not occur when an enterprise server region started or
stopped. This has been fixed.

02402188 (355001)
• To query Enterprise Server security configuration information (details of configured external Security

Managers and so forth) from the Micro Focus Directory Server when access is restricted, the authorized
Enterprise Server user must have at least Read permission for the Enterprise Server Administration
resource class User Administration entity.
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(285199)
• Micro Focus Directory Server now restricts access to enterprise server regions that a signed-on user is

not authorized to view.

02305916 (285169)
• Four new MFDS-only audit event codes (2 300, 2 301, 2 302, and 2 303) have been added. See Audit

Event Codes in your product Help for more information.

02412285 (365149)

PL/I Support

Back to the list

• When assigning a PICTURED item into a FIXED DECIMAL, FIXEDOVERFLOW is now triggered if
enabled and the target source or precision is not large enough to fit the PICTURED representation.

(400099)
• The Open PL/I compiler erroneously allowed OFFSETVALUE(POINTER)), namely

offsetvalue(sysnull()). The correct usage is: offsetvalue(binarvalue(sysnull())).

(386070)
• The internal consistency error in the PUT EDIT statement with a DO-loop that was never iterated has

been fixed; however, we recommend avoiding dead DO-loops in PUT EDIT statements as they result in
redundant code.

02518315 (407194)
• The Open-PLI compiler now performs Restricted Expression Evaluation on  AUTOMATIC, DEFINED,

and BASED declarations in addition to STATIC declarations as in previous releases.

00368483 (11358)
• The OPTIONS and LIMITED attributes now imply type ENTRY to correct a problem wherein type was

not specified and the default type was set by applying the I-N rule to the variable name.

02048549 (165087)
• The behavior of the PRECISION built-in was incorrect for most data types, except FIXED BIN, FIXED

DECIMAL, and PICTURE. This has been corrected.

(363237)
• When passing an array argument to a procedure with differing array dimensions or extents of the

corresponding parameter descriptor, a dummy argument was created. To correct this, a Severe
diagnostic message is now generated instead. In addition, when an array argument with variable
extents was passed to a procedure whose corresponding parameter descriptor had constant extents, a
dummy argument was created. To correct this, the array argument is now passed by reference and a
Warning diagnostic is generated. Both of these issues apply to passing arrays without surrounding
parentheses.  

02310772 (286006)
• Previously OPTIONS(FETCHABLE) was not implied by the coding of a RELEASE statement for an

ENTRY. This has been fixed.

01862366 (120035)
• Data exception 8097 now occurs when the sign nibble of a fixed decimal value does not contain a valid

sign 0x0A thru 0x0F during an arithmetic operation, conversion, or assignment.

02198788 (222107)

Run-Time System

Back to the list

• By default, CTF information no longer appears in AUX Trace of an enterprise server region. To enable it,
you now need to set mftrace.emitter.es#level in the MFTRACE_CONFIG.
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(328008)
• Previously, .NET COBOL applications that use OpenESQL/ODBC could fail to run with a license error

when deployed to a COBOL Server. This has now been fixed.

02490119 (406153)
• If an error occurs during thread clean-up, the runtime will now attempt thread clean-up again. If it fails

for a second time the runtime will call _exit() to terminate the process immediately.

02286519 (258130)
• Attempting to call COBOL functionality after calling the cobtidy() API, to de-initialise the COBOL

RTS, will now result in a COBRT090 error message.  Previously it was documented that the results
were undefined and it could cause subsequent problems, and/or errors, especially in a threaded
environment.  The aim of this change is to give a more meaningful error message, earlier, to help
diagnose such issues.

(301136)
• The limit for the MAXGENERATION emitter property (for both BINFILE and TEXTFILE) has been

increased from 10 to 100. The file size limit for each of these generations, as set by the MAXFILESIZE
property, is 1000000KB.

02405466 (359001)

Setup Issues (Windows)

Back to the list

• Micro Focus Host Access for the Cloud emulator replaces the Micro Focus Rumba+ Desktop emulator
previously supplied with the installer for Enterprise Developer for Eclipse or Visual Studio. Customers
that have Rumba+ Desktop entitlement can continue to use it within Rumba+ Desktop.

(335003)
• In Windows 11 it is now possible to open COBOL 32-bit and 64-bit command prompts from the Terminal

application.

(421016)
• On Windows, you must uninstall earlier versions of this product before installing 9.0.

(380028)
• 32-bit Windows is no longer supported.

(382034)

Visual Studio IDE

Back to the list

• In this release, new native COBOL and PL/I projects in Visual Studio are configured to build on both x86
and x64 platforms. If the project is added to an existing solution, the build target configured for that
solution will be used. For new solutions, the x64 targets are always selected by default. This change in
behavior does not apply to Dialog System projects or imported 32-bit Net Express projects. There are
some known limitations of x64 templates - e.g., Assembler is 32-bit only, so users will need to set the
correct platform. Some templates remain 32-bit only.

(409099)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• An issue with the Call method in the COBOL RunUnit class prevents it from being used when you target
the .NET Framework. A fix is going to be available with Patch Update 1 of this release. This issue does
not affect .NET 6.

• .NET COBOL projects only support Windows and Linux OS. The Create a new project dialog box in
Visual Studio, however, shows other platforms as supported.

• If, after installing the product for Visual Studio 2022, you cannot access the Micro Focus functionality,
execute the following command from a Visual Studio command prompt:

devenv /updateconfiguration

• The Server Core form of Windows Server 2019 is not supported.

• In Enterprise Developer 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur
with running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Enterprise Developer 3.0 or earlier, then executed in
Enterprise Developer 4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Enterprise Developer 6.0 and later, the .NET COBOL and JVM COBOL
run-times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a
version 5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue,
you need to recompile any programs that use this construct in the newer versions of Enterprise
Developer.

Program that do not use NATIONAL data, or those that have been recompiled in Enterprise Developer
6.0 or later are not affected.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• CICS Support
• COBOL Language Server
• Code Analysis
• Codeset Support
• Common Communications Interface
• Communications Server
• Compiler
• Containers
• Data Tools
• Debugger
• Dialog System
• Documentation
• Enterprise Server
• Enterprise Server for .NET
• File Handling
• HA Cloud Support
• IBM Language Environment for OS/390 & VM Support
• IMS Support
• JCL Support
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Common Client
• Micro Focus Cryptographic Library
• Micro Focus Directory Server
• Micro Focus License Administration
• PL/I Support
• REXX Support
• Run-time System
• SQL: COBSQL
• SQL: HCO for DB2 LUW
• SQL: HCO for SQL Server
• SQL: HCO for PostgreSQL
• SQL: MBDT Utilities
• SQL: OpenESQL
• SQL Option for DB2
• Visual Studio IDE
• XML Support

CICS Support

Back to the list

• A problem with generating a COBOL copybook in the correct location and/or with the correct filename
when the BMS mapset did not define the LANG parameter has been fixed.
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(380001)

COBOL Language Server

Back to the list

• Some performance issues when requesting workspace symbols in large workspaces have been
resolved. The operation is now limited to files that are open or parsed.

02384141 (338011)

Code Analysis

Back to the list

• MFDASMX no longer crashes when download process is initiated.

02411250 02427959 (363118)

Codeset Support

Back to the list

• The DISJOINING clause now works as expected when a DBCS hyphen is specified as part of the prefix
or suffix.

(296145)

Common Communications Interface

Back to the list

• A handle leak on failed ISC connection attempts has been fixed.

02413198 (381021)
• TLS connections failed when a trust anchor was not specified. This has been fixed.

02534509 (446004)

Communications Server

Back to the list

• The MFCS resource leaked under certain circumstances. This has been fixed.

02257630 02405587 (254003)
• If an Enterprise Server listener was disabled at region startup, an attempt to start it while the region was

running would fail, possibly generating an exception or signal logged by the MFCS process. This has
been fixed.

(401103)
• Enterprise Server now supports stopping and restarting a stopped listener even when conversations

using that listener are still open. In previous releases, a listener could be stopped while there were open
conversations, but not restarted until those conversations ended; this restriction has been removed.

Note: Open conversations continue to be usable.

(244018)
• ESCWA can now display the enterprise server region console.log file if its location has been

changed from the instance system directory to another location.

01970295 (313012)
• An issue with the Micro Focus Communications Server failing when restarted automatically has been

fixed.
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(313031)
• An issue that caused a connection authorization failure for TN3270 clients that use ELF or DCAS to

connect to Enterprise Server has been fixed.

(260042)
• An issue with using the Enterprise Server DCAS facility with TN3270 in "internal" mode on Linux and

UNIX has been fixed.

02429147 02433532 (375009)
• In Enterprise Server, the Communications Server process (mfcs) now logs the correct messages when

an HTTP conversation is terminated prematurely by the client.

02212920 (258094)
• Enterprise Server's handling of conversations aborted by the client or as the result of a network issue

has been improved, including fixes to resource leaks and error reporting.

(364115)
• The mfdepinst command now uses the MFDS credentials supplied in the configuration file or on the

command line for all requests to MFDS. This corrects a usability issue with installing COBOL Web
services or EJBs under Enterprise Server when the directory server is secured.

02373698 (254038)
• An issue with the Web Services and J2EE connector that caused chunked HTTP requests to be

improperly processed has been fixed.

02378445 (321037)
• The DCAS feature of Enterprise Server has been enhanced to support extracting the Enterprise Server

user ID from the CN (Common Name) of the Subject name of the client certificate. This can be useful if
you have many client certificates to provision. See DCAS Security and DCAS conversation type in your
product Help for more information.

02442474 (384003)
• Enterprise Server's ability to detect conversations closed by the client or by errors such as network

failures has been improved. These conversation failures are now detected sooner, releasing
communications-related resources and providing better error reporting. See [idle check] Section in your
product Help for more information.

02412841 (365106)
• A new option has been added to the mfdepinst utility, --replace, removes existing package and

service definitions for the same namespace before installing the services defined by the CAR file. See
mfdepinst command in your product Help for more information.

(363026)

Compiler

Back to the list

• An 013-R error generated on compilation has been fixed.

02501331 (401125)
• A new directive, ILSTRINGLOAD, is now available for .NET COBOL programs, which can help in

situations where a program with a very large number of distinct alphanumeric literals causes internal
limits to be exceeded in a class (and at which point, an error is generated). Use the directive to create
these literals in a backing file, which can then be converted to strings at run time.

02170649 (380058)
• A program containing a debug line as its first line of source now compiles with an expected syntax error,

rather than a Compiler crash.

(306070)
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• Querying the subordinate items of a group defined in a DECLARE statement now works as expected.

(414100)
• Debugging of a program with a copybook located via COBCPY, where the value of COBCPY is

extremely long, now works as expected.

02298722 (276005)
• Using a PROPERTY as a call parameter now compiles and executes as expected.

(5357)
• A query expansion of OCCURS DEPENDING ON tables now correctly reflects the current size.

02500813 (405134)
• The Outline view in the IDE is now available for all programs, irrespective of syntax errors encountered.

02297623 (285151)
• An ALLOCATE statement RETURNING a subscripted pointer now executes as expected.

(369004)
• An ADD .. TO property statement now executes as expected.

(6503)
• The 'AT END' phrase of a file statement is now correctly distinguished from dereferencing syntax

specified in the same context.

(6149)
• INSPECT CONVERTING TO HIGH-VALUES now works as expected with the CHARSET"EBCDIC"

directive.

02317578 (286071)
• The CP preprocessor now respects the setting of the SOURCE-ENCODING Compiler directive.

02463619 (394012)
• Reference modification with an implicit length on the result of an intrinsic function now executes as

expected.

02269123 (258090)
• A MOVE CORRESPONDING statement with nested subscripting now executes as expected.

02473286 (395097)
• A background parse of COBOL source containing illegal code and characters before the main COBOL

program now produces full syntax checking consistent with previous releases.

02393247 (352074)
• INSPECT .. REPLACING more-than-one-byte BY SPACE is now producing the expected execution

results.

02521582 (411107)
• The CP preprocessor now correctly expands copybooks when COPY REPLACING is active and the

copybook name partially matches the replacing text.

02541659 (427024)
• A COPY REPLACING statement that results in a replacement line of more than 256 bytes is now

processed as expected.

(301078)
• Programs called with a CHAIN statement, which use their own file handler to access the filename

pointer in the FCD, now execute as expected.

(286017)
• A query of an item in a variable-length group with an UNBOUNDED table now returns the correct value.

02500660 (403177)
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• Error message COBCH1554 More than 65535 statements in a paragraph. Cannot
produce debugging information is no longer reported for compilations where debugging
information was not requested (i.e., NOANIM specified).

02525192 (415062)
• Specifying dfheiblk and dfhcommarea as USING parameters on the Procedure Division header for a

program compiled with CISECM() now works as expected regardless of the case used.

02538907 (439076)
• A CALL statement using the 'DATA AT' syntax to pass a dereferenced parameter BY REFERENCE now

compiles and executes as expected.

(351091)
• For improved mainframe emulation, referring to the LENGTH OF a linkage item that does not have

addressability no longer receives a warning message.

02520501 (410013)
• The user responses for the ERRQ Compiler directive are now all respected correctly.

(350010)
• COMP-1 and COMP-2 data types compiled with DIALECT"ACU" now receive a syntax error when a

PICTURE description is absent.

(296032)
• When the LANG environment variable is correctly set to match the source encoding of the COBOL

source file, the Compiler now completes the compile successfully.

(390023)
• The DIALECT"MF" Compiler directive no longer affects the user-specified setting of the SETTING

directive.

02449496 (390008)
• A STRING statement with 'DATA AT' operands now executes as expected.

(260018)
• Level 88s defined in a typedef may now be referenced through pointer dereferencing.

(377067)
• A CALL ... BY VALUE operation of certain numeric types, which is not allowed on the IBM mainframe, is

now correctly flagged under a mainframe dialect.

(310004)
• $if syntax is now processed correctly in all cases.

(318040)
• For better mainframe emulation, a data declaration specifying 'OCCURS UNBOUNDED' without a

minimum value is now accepted without error.

(414182)
• When using a typdef-item at pointer that was not unique in the typedef group, the Compiler compiled

without error; however, the pointer sometimes dereferenced at the incorrect address. This scenario now
produces a COBCH0005-S User-name not unique error message.

(415140)
• The reserved word FIXED is now treated as context sensitive, enabling you to also use it as a data

name, and ensuring better emulation of IBM Enterprise COBOL.

02526399 (409102)
• The DISPLAY-PICU(UTF-8) option now operates correctly with OUTDD when using Enterprise Server.

(297005)
• A new Compiler directive, ALPHA-LIT-CONT, determines whether continuation of non-numeric literals

includes spaces up to the right margin, or simply to the end of line.
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(380072)
• A DECLARE value can now be expressed as an arithmetic expression in native COBOL.

(386138)
• The INITIALIZE condition-name syntax erroneously compiled without error. This now correctly

returns a syntax error for all scenarios.

02468662 (394064)
• An INSPECT statement used inside a class method no longer causes generation of invalid .NET or JVM

code. (This problem did not apply to procedural COBOL programs.)

02504599 (403183)
• When debugging programs compiled with sourceformat(fixed), attempting to quick-watch

variables with long names, or at a deep level of nesting within a group, could be unsuccessful.  In
addition, hovering over such variables while debugging failed to show the value of the variable. These
issues are now fixed.

02489352 (401187)
• When using named parameters to access a method in a generic class, the Compiler could produce a

spurious system error. This is now fixed.

02418658 (369012)

Containers

Back to the list

• We strongly recommend that you create Micro Focus base product images with the bld.sh script using
the provided Dockerfile/Containerfile. Images created using alternative methods might fail with the
message 245 There are no valid product licenses unless the image includes the
CONTAINER environment variable. This release ensures that the provided Dockerfiles/Containerfiles
include this environment variable.

02555217 (439070)

Data Tools

Back to the list

• The Data Tools editor could display incorrect record numbers for variable sequential files following a
Find operation. This has been fixed.

02516058 (411005)
• In the Data Tools editor, there was an issue with viewing the last page of records in a sequential

variable file when the Quick final page preference setting was enabled and the file was defined with a
minimum record length of 0 or a large variable record size range combined with a large Records per
page preference setting. This has been fixed.

02487096 (397034)
• The performance of the Search > Go To navigation feature of the Data Tools editor has been improved

for variable and line sequential files.

02399254 02480008 (399043)
• The Data Tools editor Filter could timeout on large datasets opened through Fileshare, this no longer

occurs and the Filter operation can now be stopped using the Stop loading button on the status bar.

02368849 (313029)
• Editing/deleting line sequential file records no longer hangs when using Date File Tools.

02239120 (259127)
• When attempting to open data sets in the Data File Editor, file names containing a $ sign are no longer

incorrectly trimmed.
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02194216 (221086)
• Data File Tools no longer attempts to open unrecognized file formats. Instead, an error message

appears explaining which format is invalid.

02308449 (281015)
• You can now copy hex values of selected records from the unpacked rows at the bottom of the screen

using the Copy Hex option available on the context menu the Edit menu. This option is visible only
when the hex toggle is enabled.

02396732 (352067)
• When copying a record to an external destination, the NULL Byte character is replaced by a character

specified in the Preferences dialog box. The default replacement character is a period (.).

02396678 (350053)
• The flickering of text within the DSN filter, when using the Data Explorer in the Data File Editor, no

longer occurs.

02155507 02380648 (224010)
• The Toggle Hex function now shows hexadecimal values under each line in the editor, not only the

selected one.

02342260 (297080)
• Field values of the Data File Tools File Information dialog box can be selected and copied to clipboard.

02396730 (352047)
• When using the Data Explorer to open data sets, the DSN filtering and Fileshare settings now persist

when opening multiple files.

02396643 (351058)
• Horizontal scrolling in files with variable-length records did not work as expected when a short record

was selected. This is now fixed.

02150974 (202028)
• It is now possible to start mfdatatools2 from the command line to open a catalogued file from an

enterprise server region.

00501248 (71267)
• In the Data File Editor, a preference has been added to specify the maximum number of requested data

sets in the Data Explorer view. If a catalog contains more data sets than the maximum requested
number, a More data sets in catalog stub appears at the end of the list.

02396657 (350052)
• You must configure a TS model to ensure that Data File Editor correctly honors file locking across all

enterprise server regions in a PAC.

02529725 (413062)
• Previously, the DFCONV utility would produce an error when converting sql:// database files. This

has been fixed.

02497741 (403103)
• A performance enhancement has been made when listing PDS members within the Data File Editor.

02380628 02381204 (331003)

Debugger

Back to the list

• Debugging a statement that goes up to column 255, with the Autos window active, now works as
expected.

02289017 (271031)
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• Expanding a dereferenced group item in the debugger now correctly shows the data for subordinate
items.

(363158)
• Previously, CBL_DEBUGBREAK did not invoke the debugger in .NET COBOL applications. This has

now been fixed and the built-in "Choose Just-In-Time Debugger" dialog box appears during invocation.

02388923 (348042)
• An issue has been fixed where the list of processes for 'attach to process' debugging could be displayed

incorrectly.

02458536 (386153)

Dialog System

Back to the list

• An issue with the dialog system painter clearing the screen when resizing a control has been resolved.

02367685 (330012)

Documentation

Back to the list

• Information on CICS internal transactions have been added to the product Help. See CICS Internal
Transactions in your product Help for more information.

00367280 (13485)
• The ENDEVOR_DSNQUALIFIER and CHANGEMAN_DSNQUALIFIER parameters specify a HLQ and

their values must be limited to 8 characters in length. This has been clarified in the product Help.

02477878 (393134)
• The product Help has been updated to provide a description for the Data Set Services error

message MFMDS015E.

3206480 (12288)
• Enterprise Server security configuration options have been updated. See Security Configuration

Custom Configuration Information in your product Help for more information.

(411024)
• Information on configuring an OpenLDAP server has been updated. See Configuring the OpenLDAP

server in your product Help for more information.

02387889 SF:02437494 02437494 (356021)
• The CASESM Security Manager was part of the legacy security model used in the Net Express and

Server Express 5.0 and earlier products. As part of this, the legacy ESMAC user interface pages had
Security Keys as configurable options. In ESCWA, these can only be accessed by the Client Web API
and are not available in the ESCWA user interface pages that are equivalent to the corresponding
ESMAC pages.

02276034 (259095)
• The OSESM tracing option has been added to the configuration information in the product Help.

02145921 (202197)
• The PL/I documentation has been updated to include information for the mfexecpp Utility.

00368502 (11640)
• The product Help for optimizing the performance of the CICS Terminal Control has been corrected.

3239997 (12590)
• The tutorial CICS Web Service Provider from JSON has been updated to provide additional guidance

for the user.
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3218247 (13347)
• The casrdtup utility supports the DEFINE and DELETE commands only. 

Note: The combination of DEFINE with the command line option /o can be used to overwrite
existing definitions as an alternative to ALTER.

02480002 (401027)
• Setting ES_PRODUCTION=Y will prevent debugging on Enterprise Server regions.

02208272 (346026)
• The documentation sample in the Using CobolBean for Instance Data Java topic has been corrected.

(409036)
• The product documentation has been updated with the current name and contact information for Micro

Focus Customer Care. Any instance of the older terms for customer support remain in the
documentation because it is present within the product itself.

(377012)
• The SQL Server RM Switch Module topic has been updated to remove the [directives] option for build

mssql. The option is not valid and ignored by the system.

3172383 (13152)
• The documentation has been corrected to describe the duplicate cursor effect.

3172533 (11320)
• The product documentation now correctly states PF_RO_CURSOR=8 as default when using

BEHAVIOR=MAINFRAME with SQLServer.

00372417 (12688)
• The product documentation now correctly lists the MVSSPLPB utility in upper case.

02328509 (351109)
• The documentation has been updated to include information on syntax and examples of usage for the

PUTENV Dynamic File Allocation facility. 

(207051)
• The product documentation clarifies that the Serial Scheduling option for defining an IMS Transaction is

not supported.

00365817 (13338)
• The IMS Error Message IMSRT0048E has been documented in the product Help.

02227051 (245093)
• The documentation has been updated to show that only under an MF dialect can you omit the Working-

Storage Section heading.

3245726 (28060)
• The documentation has been updated to clarify that the paper size is calculated in one-hundreths of an

inch for .NET COBOL programs using the  PC_PRINTER_DEFAULT_PROPERTIES library routine.

(386105)
• Documentation for the CBL_STRING_CONVERT library routine has been enhanced to include

information on converting from Base64 ASCII or EBCDIC to Base64 BINARY, and vice versa.

(395072)
• The documentation has been updated to clarify support for the following: the CBL_GET_ERROR_INFO

and CBL_CREATE_STACKDUMP library routines, the stackdump_on_error tunable, and the
cobgeterrorinfo function.

(385041)
• The cob command examples in the documentation have been updated.

(403044)
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• New documentation has been added that gives more detail on how to use the CBL_CTF_* library
routines. See Using the CTF Library Routines in the product documentation for more information.

(264040)
• The PL/I documentation has been updated to provide reference information for the -bifprec compiler

option.

02268330 (259038)
• The Micro Focus Unit Testing Framework documentation has been updated to explicitly state that the

MFUPP preprocessor is intended for use only within the confines of the testing framework.

02259026 (258085)
• Some of the screen shots in the MFDBFH documentation have been updated to show MFDBFH-

specific URLs in ESCWA.

(301083)

Enterprise Server

Back to the list

• Now users who have overlapping long names like USER1234 and USER12345 will not have overlapping
permissions when they have distinct mapped short names.

02529441 (440070)
• In Enterprise Server External Security Facility (ESF), requests to generate a passtoken (including for

RACF-style passtickets used by DCAS) could sometimes be rejected as unauthorized attempts to
create surrogate passtokens even though the passtoken request was not for a surrogate. This was due
to a case mismatch between the request and ACEE. This has been fixed.

02433532 02442474 (399097)
• The ESF could corrupt the credentials used to connect to an LDAP server when auditing was enabled,

causing a critical security failure and preventing enterprise server regions from starting. This has been
fixed.

02518028 (415116)
• MLDAP ESM now supports the use of the mfsecret: syntax for retrieving the security manager

credentials (authorized ID and password) from the vault. Those fields in the Security Manager definition
in ESCWA can be specified using the forms:

        mfsecret:configuration-name:secret-path

or:

       mfsecret:secret-path

02548082 02554256 (440042)
• Mfsecrets crashed when running as multithreaded. This has been fixed.

(381004)
• A problem that prevented the AES provider on big-endian platforms from correctly reading vault secrets

has been fixed.

(430032)
• An incorrect signal 11 was generated from mfsecrets when getting the username for audit. This has

been fixed.

(382026)
• For Enterprise Server LDAP-based security, two new options, [Operation] group membership uses

short name and [Operation] search users by short name, permit applying user and group data to
users known to that Security Manager only by their short name (the Enterprise Server user ID). See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

02344601 (301036)
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• In ESCWA on the Catalog page, you can now use the Line Wrap switch to toggle line wrapping for long
lines.

02289615 (258187)
• The ESCWA SEPs page displays Transient and Debug SEPs.

(327011)
• In ESCWA, accessing the Catalog file data has been improved by modifying the page layout.

02154749 (202107)
• In ESCWA, focus would not be put into modal dialogs when opened. This has been fixed.

01995433 (156067)
• ESCWA now displays more clearly when operating in Windows high contrast mode.

01995438 (161036)
• In ESCWA, the maximum height of list menus have been limited so that they do not overflow the screen

from their position, with a scroll bar to access all items.

02499988 (403117)
• The ESCWA and ESMAC JES Control page now carries out backend authorization checks against

cassub ESF resources.

(388029)
• In ESCWA, the SEP List page did not correctly sort the list by ascending or descending order. This has

been fixed.

02382568 (352007)
• ESCWA skipped entries on JES Catalog and the Spool DD display if the page size was greater than the

ESMAC limit. This has been fixed.

02501609 (407095)
• In ESCWA, some fields on the CICS DCT definition page have been fixed.

02340251 (296056)
• ESCWA was not able to bind to a hostname containing the w character. This has been fixed.

(296023)
• The ESM password is no longer disclosed in the /esf endpoint request.

02554256 (450046)
• You can now force the deletion of a JES Catalog entry if the first delete action fails.

02503936 (408004)
• Reduced the number of password save prompts encountered when navigating ESCWA using the

Firefox Web browser. 

02324422 (306001)
• The IMS transaction threshold was not being disabled when the Use System Value was set. This has

been fixed.

02513511 (406144)
• In ESCWA, the FCT Backward and Forward Recovery will no longer be disabled when Use Catalog is

selected.

02416596 (364107)
• ESCWA failed to display Spool DD Entries on remote machines for versions earlier than 7.0 patch

update 11. This has been fixed.

02391716 (352054)
• When ESCWA was configured for TLS, it failed to stop when using escwa --shutdown from the

command line. This has been fixed.

02405704 02004795 (365071)
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• In ESCWA, the Spool view now maintains the filter used between browser sessions.

02497901 (402095)
• Added missing annotation for ESCWA trace point.

02538486 (415187)
• ESCWA had duplicate CTF trace IDs. This have been fixed.

02524827 (409072)
• In ESCWA, an issue prevented the reselection of the same file twice when submitting JCL. This has

been fixed.

02198917 (222123)
• In ESCWA, the additional column File Size has been added to the catalog list view.

(403123)
• ESCWA might fail to disconnect from a Redis instance and reconnect to another. If this occurs you can

manually trigger a reconnect action by clicking the Reconnect button on the Scale-Out Repository
Information page.

(363105)
• ESCWA now reports the UUID of the PAC member that processes a batch job.

(289008)
• Implemented support for advanced job restart parameters on the JES job pages.

(271045)
• If ESCWA auditing is enabled from the Configuration page, or when ESCWA ESF auditing is enabled

from the Security > ESCWA Configuration page, then an auditing event is emitted, 2 19 (auditing
stopped), or 2 20 (auditing started). See Audit Event Codes in your product Help for more
information.

02412285 (365156)
• In ESCWA, you can now rename catalog data sets from the Catalog page. See Adding and Editing the

Catalog Entry in your product Help for more information.

02501074 (403136)
• In ESCWA, the “Historical Statistics Detail for Transaction” and “Historical Statistics” pages now

display time in milliseconds and the accuracy for latency and response information has been improved.

02504559 (405096)
• In ESCWA, the additional columns LRECL, RECFM, and File Size have been added to the catalog list

view.

02527126 02527132 (409103)
• The spool job-name page has been split into General, Messages, DD Entries, and Job Steps tabs.

02527108 (411136)
• In ESCWA, the Socket Close field has been added to the CICS URIMap resource. See the Universal

Resource Identifier Map and Active Universal Resource Identifier Map topics in your product Help for
more information.

(363101)
• In the ESCWA page for displaying spool output, it is no longer possible to request more than 99,999

lines. This limitation has also been addressed in the ESCWA interactive API documentation.

02212126 (246026)
• In ESCWA, the IMS Transactions page now has additional columns for Class, Priority, and Process

Limit.

(252019)
• A new CGI threshold type has been implemented in Enterprise Server. This enables you to set up

threshold values for ESCWA and ESMAC requests by applying the global =CGI to all ESCWA and
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ESMAC requests, or by specifying the corresponding casrdo or casrdj module that you want to
control.

(377073)
• MFDS no longer supports XA reconnect attempts.

(427068)
• ESCWA now supports merged spools. See Spool in your product Help for more information.

(246044)
• In ESCWA, the PCT Security flag is now displayed on the Active PCT page. See Active PCT in your

product Help for more information.

(335002)
• Resolved an issue with a mutex deadlock created when MFDBFH attempted to emit a message during

a cascd shutdown. 

02468209 (406002)
• An RTS 114 error related to CICS PPT RESCOUNT processing has been fixed.

02380883 (331015)
• A problem that caused Web Service client calls to fail after an upgrade has been fixed.

02320601 (307054)
• An intermittent Access Violation in mfredis.dll sometimes occurred when a batch job abended. This

has been fixed.

02328218 (296144)
• ECI transactions were not being committed at the end of task. This has been fixed.

02497005 (403085)
• An issue that resulted from pressing the Clear key following a EXEC CICS SEND PAGE command has

been fixed.

02423737 (375058)
• The user ID was not sent across on a Distributed Program Linking (DPL) from a CICS Web Interface

(CWI) request. This has been fixed.

02357738 (306068)
• The recovery of processes by casmgr now occurs in the same order in which they were terminated.

02449487 (389051)
• A bitism issue with the triggers provided with the product has been fixed.

02554978 (449002)
• An issue with updating a transaction ID in ESMAC has been fixed.

(264059)
• A WEB RECEIVE SESSTOKEN sometimes threw an RTS 114 error in cascwi. This has been fixed.

(409046)
• CICS WEB SEND commands were sometimes directed to an incorrect communications process. This

has been fixed.

02394770 (351065)
• The _FROM option on the CICS START command can now be used with AMODE compiled programs.

Caution: Do this only when instructed to do so by Micro Focus Customer Care.

02340979 02547874 (297112)
• PAC performance optimization has been enhanced to avoid PSOR access when the _FROM option is

used on CICS START.
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02541046 (425006)
• Temporary storage queues of type Process Local now work in AMODE applications.

02341118 (296055)
• Using the CICS TRANSFORM command within a pipeline handler program sometimes resulted in a

LANG ABEND. This has been fixed.

00365824 (13246)
• Dynamically enabling HSF sometimes resulted in shared memory corruption. This has been fixed.

(411104)
• In a PAC, closing an FCT that referenced a catalogued file sometimes resulted in a truncated filename

after 44 characters. This has been fixed.

02421476 (364152)
• In a PAC, multiple updates of the same CICS resource within the same millisecond could result in an

inconsistent state between different enterprise server regions. This has been fixed.

(90011)
• JES active job recovery in a PAC failed to mark the job as complete when the enterprise server region

originally processing the job was restarted. This has been fixed.

(402004)
• The casfile, casout, casstop, cassub, castran, and casutl commands now find the enterprise

server region successfully when mfds is started with the -b option.

02307940 02202467 (286003)
• An error message was unnecessarily exposing input credentials. This has been fixed.

02409369 (363126)
• When using casout, the /y option could fail depending on the order of options used. This has been

fixed.

02371843 (313041)
• In a CICS Web Interface, after the Analyzer is called, the decoder function now receives the data

unescaped.

02512069 (405161)
• An internal transaction (ITR) was not sent to a SEP that had an EZASOKET listener started. This

sometimes resulted in a close file request failing to be processed by the SEP running the EZASOKET
listener. This has been fixed.

02394276 (350047)
• When using function shipping between two enterprise server regions, one EBCDIC and one ASCII, the

records are now correctly converted.

(405010)
• EXEC CICS DELAY was monitored for DEAD LOCK timeout, resulting in the transaction being killed.

This has been fixed.

02399944 (350093)
• The start CICS transaction was not producing the correct trace for HSF. This has been fixed.

02385015 (340004)
• When an XA issue occurred, the reason code was not always returned. This has been fixed.

02532560 (425053)
• An intermittent crash in casmgr has been fixed.

02431740 (377040)
• When sorting by Submitted, the spool records are now returned correctly.

02404702 02431279 (365041)

Resolved Issues | 39



• When performing a NEWCOPY on a data table in a PAC, not all enterprise server regions in the PAC
reloaded the new member. This has been fixed.

02406797 (364015)
• An EXEC CICS RELEASE was cancelling a program even if the rescount was not 0. This has been

fixed.

02400119 (355025)
• When trying to load an ASM data table using castran with -b for AMODE, the pointers were not

always converted to AMODE addresses. This has been fixed.

02528581 (414049)
• When using EXEC CICS DELAY in an AMODE program a RTS114 could occur. This has been fixed.

02505696 02428286 (406176)
• Thresholds are now started before the XA start for a transaction has been issued, enabling the process

to be killed if the transaction is stuck in the Resource Manager.

02365811 (306124)
• When using a CICS Web Interface (CWI) Analyzer that was compiled with AMODE 31, an ABEND

MFPM would occur. This has been fixed

02427963 (374003)
• When using the CICS command castran with the -b option, the message was not sent to the

console.log file. This has been fixed.

02389970 (348041)
• In an HTTP CICS Web Interface (CWI) request with the analyzer returning a converter program to

execute, the decoder parameter for decode-data-ptr was not set. This has been fixed.

02432166 (377025)
• When multiple requests were made from the same browser, a new TCTS was allocated, resulting in an

SOS situation. This has been fixed.

02419170 02404921 (364124)
• When using EXEC CICS DELAY before EXEC CICS RETRIEVE and ENDDATA was returned as the

DELAY, it resulted in resetting the data sent to the application. This has now been fixed

02526457 (419004)
• When using TRANCLASS and refreshing ESMAC, the data sent to a started transaction could be lost,

resulting in ENDDATA returned on the retrieve. This has been fixed.

02526457 (451029)
• An incorrect IOERR was returned from CICS READNEXT when the record was locked. This has been

fixed.

02526497 (413214)
• CESL now respects the case of the password entered. No upper-case translation occurs.

02501164 (407012)
• The sample exit program DFHUSYNC has been modified to not return cics-syncpoint-normal-88 by

default as this could overwrite the correct return-code set on a previous call to an RM.

02492604 (409026)
• If ES_ESM_PLTPIUSR is defined, programs in PLT/PI are executed under the ES_ESM_PLTPIUSR

user.

02472002 (407025)
• The RAS process is now correctly identified on a dump.

(385051)
• An issue where MQ Security Resources were prefixed when using ES_ESM_SECPRFX has been fixed.
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02483959 (406062)
• Fixed a memory corruption that occurred when logging in-doubt XA transactions in the PAC.

02304565 02319810 (284038)
• Replaced ESF Admin API LISTRESOURCE with ESF Auth for querying MQ Security Resources.

02154003 (202145)
• Updated XID generation to support UTF-8 code pages with PostgreSQL.

02296723 (273006)
• A shared memory corruption issue occurred when reinstalling a TCPIP Service or URIMAP. This has

been fixed.

(204047)
• Improved error reporting when applying advanced configuration updates in a PAC environment.

(364113)
• The casesxml utility now provides a relevant error message when no work location is provided.

02531150 (413115)
• The casstop command output misleading error messages when immediate shutdown was used. This

has been fixed.

02490512 (403132)
• The dynamic region configuration updates occasionally failed to apply. This has been fixed.

(245030)
• If an enterprise server region contained $ES_SERVER in its configuration, then it would not be handled

by casesxml. This has been fixed.

02531150 (417037)
• Enterprise Server CICS now supports the MAPPINGDEV option of SEND MAP and RECEIVE MAP

commands.

02497790 (407132)
• Support has been added for the MILLISECS option of EXEC CICS DELAY.

02428286 (377024)
• A CICS distributed program link over SNA for which the target enterprise server region was unavailable

resulted in EIBRESP=ISCINVREQ instead of SYSIDERR. This has been corrected.

02249191 (255023)
• To improve efficiency, when an enterprise server region is configured with multiple RMs and a task uses

only one, no XA log is created for the transaction.

02537701 (430016)
• When calling APPC functions, you could pass an invalid value in the first parameter which would result

in an error in the communications server layer. This has been fixed.

02428147 (372009)
• When using LU6.2 communications infrastructure between enterprise server regions, when a COMMIT

was executed by the originator, the target would incorrectly attempt to send a commit request back to
the region which sent the sync point request. This has been fixed.

02339327 (296039)
• When using LU6.2 communications infrastructure between enterprise server regions, the processing of

SYNCONRETURN on a Distributed Program Link was preventing switching between remote systems
(SYSIDs). This has been fixed.

02336501 (296104)
• When using LU6.2 communications infrastructure between enterprise server regions, an ABEND in the

target region would result in the SEP which was processing the request hanging. This has been fixed.
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02287147 (259103)
• When using LU6.2 communications infrastructure between an enterprise server region and mainframe

CICS, sync point requests executed on the target would result in an orphaned UOW. This has been
fixed.

02322602 (297014)
• A DPL request from Tuxedo over LU6.2 could result in an RTS 114 error being reported. This has been

fixed.

02531060 (421001)
• HSF records for Java ECI transactions now display the transaction name instead of CASECIP.

02338437 02353043 02394280 (296126)
• Changed the first occurrence of CASA_ECI_Function in HSF records for EXCI calls to show the

transaction ID if one is specified in the TRANSID option on the EXEC CICS LINK.

02383644 (339001)
• The latency value in HSF records could be incorrect for transactions started via DPL. This has been

fixed.

02504559 (407143)
• Some Redis connections from castmc, castrc, and cassi processes were not being disconnected

and remained open. This has been fixed.

02198949 (222162)
• The casstart utility now accepts variable wait times for the /w parameter. See casstart in your

product Help for more information.

(365010)
• HSF now reports that 100% of transactions meet performance criteria when no transactions are

measured for that period.

(385065)
• Dynamic Debugging failed on secure enterprise server regions with certain security configurations. This

has been fixed.

02408468 (363059)
• The JCL command cassub is now designated as a system program and as such will not be cancelled

by runtime container de-initialization.

02356121 (307019)
• Issues with CICS NEWCOPY and Phase In when used in a PAC environment have been fixed.

(259078)
• Enterprise Server Clustering is now deprecated. Micro Focus recommends that you adopt the Scale-

Out Performance and Availability Cluster (PAC) solution for your clustering requirements. See Scale-Out
Performance and Availability Clusters in your product Help for more information. In addition, the
LOCKDB feature has been added to replace the functionality of the Enterprise Server Cluster Global
Lock Manager (GLM). See Enterprise Server LOCKDB for more information.

(363157)
• An enterprise server region sometimes crashed after MFCS and the ADMIN SEPs were killed. This has

been fixed.

02415369 (364089)
• A new CGI threshold type has been implemented in Enterprise Server. This enables you to set up

threshold values for ESCWA and ESMAC requests by applying the global =CGI to all ESCWA and
ESMAC requests, or by specifying the corresponding casrdo or casrdj module that you want to
control.

02426463 (370004)
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• The spool view page no longer displays errors even if another spool page has not been loaded.

02514961 02518028 (407109)
• You can use the new ES_HARD_KILL_PROCESS environment variable to modify how Enterprise

Server kills a process. See General Enterprise Server Environment Variables in your product Help for
more information.

02365440 (355015)
• Added a new Retrieve action to the caspac utility to enable you to retrieve binaries loaded on an SOR.

See caspac in your product Help for more information.

(284104)
• A new /z parameter has been added to the following commands-line utilities: casfile, casout,

casstart, casstop, cassub, castran, and casutl. The parameter enables you to pass user
credentials through an interactive prompt or a redirection from the console. See the respective
command-line topics in your product Help for more information.

(303013)
• In Enterprise Server with LDAP-based security, the effect of the value 0 for the attribute microfocus-

MFDS-User-MTO-Timeout was documented incorrectly. When this value is 0, the enterprise server
region's default user timeout is used. See Defining a User with LDIF in your product Help for more
information.

02305957 (276010)
• The following environment variables can now be configured as properties on the ESCWA Advanced

Region Properties page: ES_SEP_DORMANT_TIME, CAS_SRV_CANCEL, and
 ES_MAX_CATALOG_LINES.

(348002)
• The following environment variables can now be configured as properties on the ESCWA Advanced

Region Properties page: ES_DDBG_PORT_RANGE, ES_ESMAC_DISP_MAX_OVERRIDE, and
ES_SOR_RETRIES.

(306023)
• The supported list of cipher suites has been updated to TLS v1.3.

02320601 (401139)
• EIBCALEN now has the correct value after an invalid transaction from a previous CICS RETURN

transid.

SF:# 02416565 (387026)
• PDS member names are no longer be truncated in the Data Editor when PDS names and member

names are longer than 44 characters combined.

02358793 (306041)
• An issue that prevented the user ID from being found and that then failed to report this back to the

application has been fixed.

02459379 (395007)
• An RTS 114 error on a CICS LINK to a remote system has been fixed.

02336344 (297044)
• CICS FILE OPEN was returning ILLOGIC when user catalog was enabled. This has been fixed.

02418777 (364137)
• An issue with EXEC CICS VERIFY PASSWORD when the application was compiled with the AMODE

directive has been fixed.

02461716 (393128)
• The EXEC CICS WEB READ HTTPHEADER and WEB READNEXT HTTPHEADER commands no

longer include trailing spaces in the value returned in the VALUELENGTH field. For example, the
VALUELENGTH for a header with a value of "myValue " (three trailing spaces) is now 7 instead of 10.
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02451501 (406070)
• When running with futex support, enterprise server regions would no longer start due to a logic error.

This has been fixed.

(308024)
• In TRANCLASS enterprise server regions, non-TRANCLASS Temporary Storage Queue (TSQ)

processing can now be enabled by setting ES_TRANCLASS_EXCEPT_TS=Y.

(387013)
• Support for TS queues of type Exclusive has been improved by correcting error conditions and now

retaining queue recoverability after a DELETEQ.

(386014)
• A bug in the castsc process meant that it could trap in casstore when a terminal disconnects. This has

been fixed.

(368001)
• In a PAC, access to an FCT could immediately reopen an FCT that had just been closed by another

enterprise server region. This has been fixed.

02421476 (375005)
• A WRITEQ TS using the REWRITE option against a non-existent queue was incorrectly returning

ITEMERR instead of QIDERR when running with ES_TRANCLASS_EXCEPT_TS=Y. This has been
fixed.

02515519 (405171)
• An issue with the start initiator button not being correctly disabled when a user was not authorized for

the casout resource (OPERCMDS) has been fixed.

02503261 (401173)
• A loop that occurred when trying to recover PIDs after MFDBFH lost the connection to the database has

been fixed.

02373280 02362273 (322009)
• Option USERID is now supported for EXEC CICS QUERY SECURITY.

02419858 (363211)
• MQ security was being disabled when Allow unknown resources was enabled. This has been fixed.

02328521 (288019)
• When a process dies in a PAC, casmgr in the recovery process tries to call MFDBFH to recover the

process, close all files opened by that process, and release all the locks. If the connection to the
database was lost, the call to MFDBFH would fail and the process only recovered if the connection was
restored at region termination. Updates in this release now keep track of the process that could not be
recovered and retries when the connection is restored. On region shutdown, all orphan ITRs that
belonged to the current region are now removed. At start up, all orphan ITRs that were targeted to the
region are removed.

02345487 (303043)
• An incorrect HSF latency calculation when the transaction was using a TCPIPSERVICE has been fixed.

02439855 (387136)
• When using DEFINE LIBRARY, casrdtup was hanging. This has been fixed.

02422104 (372043)
• You can now specify thresholds for ESCWA and ESMAC requests using the new type CGI and by

specifying the casrdxxx module name or a global threshold =CGI. This ends the request abnormally if
the threshold is exceeded, and stops the admin SEPs from being blocked on long requests accessing
ESCWA or ESMAC.

(372055)
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• Invalid messages have been removed from the Catalog Display when details are enabled.

02501609 (405074)
• A local memory leak that occurred when logging XA transactions in a PAC has been fixed.

02319834 (285102)
• An issue with MQ security checks when security resource prefixes are used has been fixed.

02483959 (397010)
• Ambiguous MQ security rules failed to enable security checks. This has been fixed.

02375426 (314055)
• The subsystem security switch was not being set to OFF when the MQADMIN class was not defined.

This has been fixed.

02483959 (399003)
• All authentication checks for Dynamic Debugging operations are now skipped if the casdebug entry is

not available under the OPERCMDS security resource.

02367824 (314007)
• An issue with MQ security console messages not containing the actual resource being checked has

been fixed.

02483959 (399002)
• Return code handling for create process requests on Windows platforms has been improved.

02290153 (307032)
• When using LU6.2 communications infrastructure between enterprise server regions, an ABEND raised

by the target application would result in subsequent attempts to establish a conversation to fail. This has
been fixed.

02339327 (297043)
• EXEC CICS START requests which expired immediately were being delegated to another process for

scheduling. This has been fixed.

(386090)
• When invoking a program over a SyncLevel 2 connection which executed an EXEC CICS SYNCPOINT,

the backend would raise an ISCINVREQ condition and the session state would subsequently result in a
SYSIDERR on the client side.

02312326 02329428 (285057)
• HSF reported latency for incoming remote DPL requests were not being reported correctly. This has

been fixed.

02455011 (392023)
• Windows Performance Counters now work using a V2 provider DLL and will appear in Performance

Monitor under 'Micro Focus Server System V2'.

(286029)
• Security checks are now supported for Dynamic Debugging operations. Checks are carried out against

the casdebug entry under the OPERCMDS resource class.

02337725 (296095)
• If an enterprise server region is running in a PAC with both IMS and CICS features enabled, then single

sign-on is enforced for both CICS and IMS. If you want to change the behavior, set
ES_CICS_SINGLE=N and/or ES_IMS_SINGLE=N to enable the same user to sign on to multiple
terminals for CICS and/or IMS.

(345001)
• When using casesxml, if the enterprise server definition has been exported using the -c option then

you must import using the -c parameter.

(351045)
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• If an XA commit verb returned retry n times, where n is the configurable number of retries, then the
DSNRLI function incorrectly received a return code of zero. This has been fixed.

02495509 (408003)
• An issue with the TType page (Signoff attribute) affecting ESCWA and ESMAC has been fixed.

(402014)
• In ESCWA, the Spool Completed field did not display the correct time. This has been fixed.

02470813 (393069)
• Attempting to delete a job in the input state from the Spool in ESCWA would intermittently fail. This has

been fixed.

(394029)
• The JSON ESMAC spool details module now reports the UUID of the PAC member which processed a

batch job back to ESCWA.

(293036)
• The ESCWA API call /native/v1/regions/host/port/region/users/resource has been

fixed.

02382647 (340024)
• An issue existed when filtering the spool without wildcards. This has been fixed.

02486979 (397072)
• In ESCWA, when displaying JES Catalog entries the record count information is now correct.

02209327 (246002)
• An issue where ESMAC display Count Override was not being applied when viewing files from the job

list view has been fixed.

(406141)
• In ESCWA, the limit of jobs that can be deleted from the spool has been increased to 100000.

02332690 (291038)
• Both ESCWA and ESMAC JES Control pages now carries out back end authorization checks against

cassub ESF resources.

02427674 (375006)
• Added support for passing advanced job restart parameters through the Spool Job View page.

(273030)
• Added the ESCWA JES Default User Job Submission property to the Advanced Region Properties

page in ESCWA. This property changes the default user behavior for JCL Job Submission through
ESCWA and the IDE.

02378712 (365132)
• In some circumstances MFDS incorrectly granted permissions. This has been fixed.

(365086)
• An Enterprise Server Security Manager using the MLDAP ESM Module with caching enabled no longer

incorrectly caches partial results when an LDAP search cannot return the full result set due to the
server's size limit on responses. The module will always switch to an LDAP paged search when
necessary, bypassing the cache. This corrects an issue where customers with a large number of
resource rules might sometimes get incorrect security results (typically access denied when it should
not be) after the first time that resource class was queried.

Note: If you cannot apply this fix, you can work around it by disabling caching for the Security
Manager. ESF caching, which is set in the Security properties for the enterprise server region, can
remain enabled.

02475614 (397047)
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• Enterprise Server security did not always assign supplemental groups to users in certain configurations
with multiple Security Managers, Federation enabled, and All Groups enabled. This has been fixed.

02145921 (202146)
• The ability to change passwords through the OS ESM Module was broken in version 1.10.4 of that

module. That has been fixed.

02408023 02417238 (363081)
• Issues with changing passwords through the OS ESM Module have been fixed.

02408023 02425417 (370007)
• For Enterprise Server LDAP-based security, a new configuration option, [Operation] check

constraints for already-verified users, lets an MLDAP Security Manager deny sign-on for a user even
if an earlier Security Manager has chosen to allow the Verify request. See MLDAP ESM Module Custom
Configuration Information in your product Help for more information.

02346703 (297133)
• The esfupdate utility now supports the Micro Focus Vault Facility for retrieving secrets. See To Update

Security Manager Changes Using esfupdate in your product Help for more information.

02510669 (406066)
• When both BATCHONLY and LOCALTX are set to true, one-phase-commit batch jobs no longer trigger

two-phase commit connection in the recovery transaction.

02407338 (364098)
• At the end of a CICS transaction that calls batch programs, all opened cursors are now closed.

02423443 (369016)
• The XA ODBC switch module now gets the correct server status, enabling the Enterprise Server

RECONNECT feature to work correctly.

02408845 (362020)
• XA switch modules that use OpenESQL now work correctly when the applications in Batch transactions

are compiled with XAID directive option.

02327393 (293012)
• The DB2 switch module now sets the PackagePath after switching to the user.

02269497 (258224)
• XA switch modules no longer return an MFDBFH registration error to Enterprise Server, ensuring that

non-MFDBFH transactions continue using the XA connection.

02452753 (385055)
• The correct OCI_ATTR_SERVER_STATUS is now used to query Oracle Server status.

02391332 (335016)
• XA recovery is now performed correctly for DB2 in-doubt transactions when the enterprise server region

is next started.

02474721 (402001)
• You can now build the SQL Server RM switch module on UNIX platforms. See SQL Server RM Switch

Module in your product Help for more information.

(365126)
• The Region Trace Control process (castrc) was incorrectly creating multiple connections to Redis

after a RD-NOAUTH return code. This has been fixed.

02319798 (335004)
• Intermittent CONNECT_ERROR issues occurred when accessing data from MF Directory Server via

ESCWA. This has been fixed.

02532852 (425068)
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• A socket handle leak occurred if the connection to the MF Directory Server process failed. This has
been fixed.

02435329 (382013)

Enterprise Server for .NET

Back to the list

• The LDAP External Security Module for Enterprise Security for .NET now correctly implements the
optional retry configuration parameters.

Note: This was not and is not an issue with the MLDAP ESM Module implemented in native
Enterprise Server.

02444873 (385093)

File Handling

Back to the list

• The performance the Data File Editor has been improved when navigating within variable-sequential or
line-sequential files accessed through a Fileshare server.

(401106)
• File Status no longer returns corrupt index file for a non-corrupt file, under high traffic.

02513640 (406155)
• A COBRT114 error no longer occurs when using read-direct on VB file header records.

02490607 (400074)
• Background changes have been made to the external file handler when dealing with sequential files.

(382072)
• Performance improvements have been made when navigating to the last page of a variable-length file in

the Data File Editor.

02476713 (394163)
• The OPEN INPUT of an optional file, which is not referenced in the JCL, now behaves as it does on the

mainframe.

02418838 (350105)
• Fileshare could crash when processing some unexpected sequences of operations for a connected

Data File Editor. This has now been fixed.

02409270 (365144)
• In some scenarios, zombie processes could result in an incorrect reporting of open files in the system.

This has now been corrected to better detect when such scenarios occur.

(297118)
• It was possible for an ODBC/OCI exception (such as a connection timeout) to occur in the optimized I/O

thread when accessing files via MFDBFH. This could cause the process to hang, and so defensive
measures have been taken to resolve this.

02481017 (405157)
• An issue where MFDBFH would incorrectly return a 9/139 error when attempting to open a file that did

not have a key definition area specified in the FCD has now been fixed. The behavior is now the same
as it is on disk.

02394334 (350036)
• Oracle statements were previously using deprecated OciStmtPrepare calls, which meant that the

Oracle application failover/transaction replay could not be used. This has been updated to now use
OciStmtPrepare2.
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02441885 (384027)
• A timing issue when closing the connection to the database caused an SEP to crash on region

shutdown. This has been resolved.

(254034)
• The time required to return after reading a large number of records from large files hosted in MFDBFH

was excessive due to the large number of SQL queries being executed. These queries have now been
optimized to improve performance.

02396919 (384007)
• The performance of filtering the Enterprise Server JES Spool has been improved when ordering the

content by Job ID while filtering by a specific Job Name.

02293524 02299724 (264085)
• Enterprise Server sometimes failed to recover processes that died after losing and then reestablishing a

connection to the database. To mitigate this, Enterprise Server has been updated to attempt recovery of
these processes at a later time in the event that the database connection cannot be reestablished.

(326009)
• SYSOUT SSTM data sets were being incorrectly marked as using an In-Memory record-locking strategy

when hosted within MFDBFH, which returned a 9/100 status due to multiple processes attempting to
write display statements to the data set. In this scenario, SYSOUT SSTM data sets now use the default
Table record-locking strategy.

(299014)
• MFDBFH has been updated to be sensitive to the FAN settings on an Oracle Database, and is now

immediately notified when the database attempts to drain connections. In this case, MFDBFH attempts
to establish a new connection.

(375030)
• When registering an XA connection with MFDBFH, the registration process attempted to connect to

each entry in the MFDBFH.cfg file to determine if it matched the details of the XA resource. Underlying
improvements have been made to reduce the number of connections made when the MFDBFH.cfg file
contains duplicate entries.

02459182 (390041)
• If the connection to an Oracle RAC environment was lost at a specific time, a COBRT114 error was

sometimes thrown in the XA Switch module. Additional checks have been added to the code to ensure
that this is no longer the case.

02366126 (350015)
• When using an Oracle database, if the connection was lost, the process failed to reconnect once the

connection to the database was reestablished. This has now been resolved.

02410660 (363051)
• Oracle queries that issued searches against large files used a full-table scan, slowing performance.

Performance has been improved by instructing the Oracle optimizer do a range scan instead of a full-
table scan in this case.

02516560 (406164)
• Additional diagnostics information has been added to assist in determining the cause of an RC 3 on

MFDBFH recovery processing.

02344102 (299021)
• A WRITE operation that used ADVANCING mnemonic-name sometimes threw an error. Support has

now been added to handle WRITE operations with mnemonic usage.

02209654 (246009)
• Performance when filtering the Spool queue has been be improved in situations where the filtered field

does not match the field by which the queue is being sorted.

02516560 (410086)
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• When a database ran out of available connections, stored procedures and functions were sometimes
lost. This release contains updates that reduce this risk.

02155281 (203093)
• A progress bar has been added to dbfhdeploy operations.

(381028)
• A new environment variable, MFDBFH_GRANT_USER_PERMISSIONS, has been added for Oracle

databases only to allow MFDBFH to grant execute privileges on types/procedures to specific users/
roles. This provides easier user privilege restriction on Oracle and creates a more secure environment
without having to manually modify the MFDBFH scripts. 

02459320 (389032), 02441860 (384006)
• Additional checks have been added to verify the integrity of the region/cross-region database tables

before running dbfhadmin -casprocess -recovery. If required, you are prompted to run
dbfhadmin -verify to fix the table integrity before recovery can continue.

02326339 (297036)
• A Y2W date comparison is now supported in EBCDIC.

02423850 (364166) 02326205 (285173)
• MJFTOOL now correctly converts EBCDIC to ASCII output when the file is LSEQ.

02393322 (350028)
• During a SORT, SUM now correctly works with MF_CHARSET=EBCDIC.

01909282 02349849 (124117)
• The DFSORT INCLUDE statement now supports the Y2U format with a constant.

02351201 (303076)
• A 9/139 file status no longer occurs when submitting a SORT job with an OUTFIL statement containing

FTOV and HEADER1 parameters.

02522665 (411123)
• An issue has been fixed where the TRAILER1 MIN and MAX functions were returning high values

instead of zeros when used on an empty file.

02539611 (421035)
• When using the OUTFIL statement under DFSORT emulation, RECFM is correctly set to FB

(previously, it was VB) during a COPY operation.

02353490 (303058)
• The discrepancy in MFJSORT VB Outfil LRECL checking has been resolved.

02501782 (406117)
• The MFJTOOL SORT emulation's SELECT LAST operation now behaves correctly for VB files.

02474360 (395098)
• Generating SPLICE with KEEPNODUPS using an empty input file was generating an invalid output file.

This has been corrected to generate an empty output file.

02403474 (356016)
• The validation checks that were causing unexpected behavior in ICETOOL emulation have been

corrected.

02412147 (365082)
• MFJSORT now throws an error message when the unsupported DATE4 operand is used in the SORT

card.

02435356 02389969 (375072)
• A correction has been made to the temp/dump file creation of a SORT process.

(387134)
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• The OUTFIL LRECL calculation has been corrected when there is a newline literal in the OUTREC
statement.

02500082 (402125)
• Support has been added for the ON(VALCNT,formatting) parameter of the MFJTOOL OCCUR operator.

02474081 (395127)
• The INCLUDE statement within a SORT now works with the SIGN-EBCDIC flag.

02366598 (314012)

HA Cloud Support

Back to the list

• The startsessionserver batch or script file used to start an HA Cloud session no longer launches
with CMSClassUnloadingEnabled in the Java options.

(382033)
• Additional logging capabilities have been added to the HA Cloud session server. You can set logging

levels for additional properties in hacloud.properties such as
logging.level.com.microfocus.zfe.enterprise.ConfigurationServiceEnterprise,
logging.level.com.microfocus.zfe.enterprise.ConfigurationLoader, and
logging.level.com.microfocus.zfe.enterprise.VaultAccess.

(375033)

IBM Language Environment for OS/390 & VM Support

Back to the list

• A fault in CEE3DLY that caused an COBRT227 error has been corrected.

02462693 (372005)

IMS Support

Back to the list

• A problem that prevented users from broadcasting a message to IMS terminals has been fixed.

01912390 (150003)
• A problem that erroneously caused a run-time error on start-up when a message-queue error was

detected has been fixed by replacing the run-time error with a console message.

02557482 (446006)
• A problem that delayed transactions invoked via MQ-IMS Bridge when the MQ request queue was

nearly full has been fixed. In addition, sporadic transaction-not-found errors no longer occur.

02268086 (258040)
• A database no longer fails to close in certain situations when work has been done after a QC.

02030160 (166042)
• A problem that occurred when multiple XAs were used in IMS BMP programs prevented changes from

being committed to each XA separately, even when a 2-phase commit was requested. This has now
been corrected.

02287414 (260260)
• The IMS /REFRESH PROGRAM command now forces a QC for the next GU from scheduled MPPs

allowing MPRs to cancel loaded executable modules.

(303085)
• IMS intermittently failed to dispatch new work. This has been fixed.
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(333001)
• Enterprise Server IMS TM erroneously dispatched new transactions while the DLI database was

suspended. This has been corrected.

(405164)
• A problem that caused IMS TM on 64-bit systems to continue dispatching when the database was

commanded to suspend has been fixed.

(410077)
• A problem that caused false SYNCPOINT failure reports during an IMS /REFRESH PROGRAM ALL

operation has been fixed.

02311796 (385010)
• IMS REFRESH command no longer causes a false XA error message for WFI transactions.

02311796 (319028)
• The existing ES_CESN_NO_OS390 environment variable now also applies to IMS. When set, both an

invalid user ID and an invalid password give return code 8.

02485549 (400037)
• An incorrect RX status code was sometimes returned when replacing a concatenated (LC|LP) segment

with different logical parent data, even when the virtual replace rule was specified. This has been
corrected.

02437342 (397002)
• A problem with MFS option 2 that occurred when no data was received from the screen prevented the

input segment from being compressed out of the input message even when input literals were defined.
This has been corrected.

02390758 (386139)
• To correct a problem that caused data to be mapped to the screen incorrectly, the value in the ZZ2 byte

of x'40' is now used to recognize the first segment of a new page.

02390758 (351023)
• A problem with completely clearing currently displayed data when the last page was requested with =L

has been fixed. Data is now cleared completely before formatting the last page.

02512396 (407063)
• A problem that prevented device physical paging from working correctly on multiple screens, both from

the MFS menu and via PF keys, has been fixed.

02127948 02226814 (222064)

JCL Support

Back to the list

• If a DD entry did not have a dataset name defined, it was excluded from the analysis when the job was
restarted using the auto-adjust option. This sometimes led to the job restarting at the wrong step. This
fault has been corrected.

02349857 (304005)
• A problem that caused incorrect symbols to be passed to a procedure when a DD override was applied

to a procedure step prior to the last step in the procedure has been corrected.

02457317 (389036)
• When listing catalog entries using the TSO command LISTCAT, the LRECL value was truncated to 4

digits and the high order value was not displayed. This has been corrected and the LRECL value is not
displayed using 5 digits.

02331981 (296001)
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• To fix a problem that sometimes occurred when either the IMS MPR process shut down or when a CICS
SSTM region shut down and ES_SSTM_JOB_FLUSH_ACTIVE=Y,  the lex files for the SSTM job are
now removed.

02322067 (285165)
• An error that occurred when using FREE to free a dynamically allocated new GDS has been corrected.

02424185 (363221)
• A problem with the TSO LISTCAT command that caused it to display datasets with similar names to

those requested but that were outside the scope of the entry specified has been corrected.

02532129 (415117)
• A fault that caused a new GDG version to be incorrectly removed at the end of the step that created it

has been corrected.

02344573 02342424 02354398 (301037)
• The JCL File Handler has been updated such that when SRRCMIT or SRRBACK is called, all XA

modules associated with the current unit of work are notified. The last module referenced by a SWITCH
TO call is notified last so that the focus of the next SQL statement is the same module as before the
commit or rollback.

02552872 (442022)
• A problem that resulted in the failure to load MFJDBFH_CHECK_FILE_EXIST when viewing spool files

has been corrected.

02472170 (395102)
• Do not delete the JESYSMSG using the ESMAC/ESCWA interface for a job that is currently active. To

do so could result in job failures. If the SSTM job cannot be set up for a new process, error messages
are written to the console.log file indicating the reason, for example, the JES000041E and JES000018E
messages.

02363373 (313022)
• An error that caused the CICS spool process to abend when no CICS SSTM job was defined has been

corrected. Instead of an abend, an error message is issued in the console.log file indicating that the
spool file could not be added to the job because the SSTM job does not exist.

02186416 (220036)
• An incorrect error reported when using mfcatxml with the environment variable ES_SERVER set has

been removed.

02455029 (395082)
• If a DD card specified a UNIT value that was interpreted as a tape volume, that value incorrectly

overwrote the value for the SPACE units. This has been fixed.

02330375 (294011)
• The FTP issue that sometimes occurred while performing a GET to a GDG dataset has been fixed.

02298846 (286031)
• The public catalog API has been updated to provide information about the GDG bias whether rolled in

or rolled out.

00425417 (411100)
• COND=EVEN behavior has been updated to work correctly when it is placed along with another return

code test.

02413227 (364100)
• The START operation on a dummy dataset was not returning FS=23, which is required to emulate

mainframe behavior. This has been fixed.

02261850 (258069)
• The mvscatpb function now correctly updates the SPACE-EXTENT-UNITS field of a dataset in the

catalog.
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02429430 (372030)
• An issue with the MFFTP MPUT command caused it to search beyond the scope of the LCD DSname.

This has been corrected.

02333250 (296003)
• A problem that caused datasets to be locked exclusively when a job was restarted has been corrected.

02343791 (301057)
• A problem that prevented spool housekeeping from removing orphan job spool entries from the catalog

when it removed the JESYSMSG of that particular job has been fixed.

(393056)
• MFJAMS LISTCAT of a nonexistent dataset now returns condition code 4.

02478830 (393163)
• The %PCDSN extension syntax checking has been fixed so that an invalid catalog entry is not passed

through the JCL.

(326003)
• Dynamic System Symbols, such as &LDATE or &HHMMSS are now resolved when a JCL job is parsed.

02379833 (351055)
• An RTS 173 error that occurred on region shutdown in the printer exit process when no datasets had

been printed has been corrected.

02382404 02392374 (351034)
• MVSCATPB, the public catalog API, now returns the pc-dsn of a PO; however, that value might be

empty if one has not been assigned.

02436618 (382024)
• A problem that caused the value of SYSUT2 LRECL to be incorrect when copying from SYSUT1 in

IEBGENER/ICEGENER has been corrected.

02422566 (372032)
• The REN (RENAME) command was not recognized by IKJEFT01. This has been corrected.

02529686 (413035)
• To avoid an MFFTP error, execute SAF authority checks against permanent datasets with the resolved

dataset name, and not against temporary datasets.

02423925 (363236)
• MFFTP now supports DDNAME.

02265813 (264046)
• Spool housekeeping now returns COND code 4, when the bulk delete operation fails with an FS=23,

record not found.

02478798 (399068)
• MFFTP now provides the local PC filename to the user exit instead of the temporary EOL file that was

used in the file transfer.

02512749 (405100)
• You can now pass more JOB information to the MFFTPXIT user exit, including job name, job number,

step name, step number, proc name, and proc number.

02386513 (340016)
• MFJAMS now correctly updates the SPACE attributes of each VSAM component in the catalog.

02434035 (379009)
• The MERGESPL.jcl file is now correctly located in the cpylib folder specified in the documentation.

(264034)
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• A problem that prevented the altered disposition of a dataset from being reported when using UCC11
settings and restarting a job has been fixed.

02394363 (350045)
• A display statement in a CICS program sometimes encountered a problem when the process

terminated, potentially leaving an orphaned lock in the region. This has been resolved.

02554567 02554929 02562916 02574430 (451017)
• A problem with the REPRO of a VSAM dataset using the PATH to the alternate index has been fixed.

(10367)
• Informational messages that show the library from which a PROC or an INCLUDE group was loaded

are now written to the job log.

02354463 (304076)
• An EXPDT entry consisting of a year and 0 (zero) days is now accepted, and an informational message

issued (JCLCM0644I).

02074959 02558534 (183053)
• An issue with nested IF conditions not being correctly evaluated within an IF ABEND condition has been

resolved.

02456500 (386115)
• A problem that resulted in limiting the deletion of spool records via the ESCWA interface to only one has

been corrected.

(414167)
• A problem that caused the expect next GDS version to be out of sync with the actual version has been

fixed by improving GDS tracking. The listing of a GDG Base using the IDCAMS LISTCAT command with
the ALL option has been enhanced to show the rolled-in GDS, but not showing associations until the
GDG has been used in a job following the update).

02207067 (246045)
• To ensure that the DCB parameter is honored, do not copy the LRECL from DATACLAS if the dataset is

allocated using DCB=MODEL in the DD statement. 

02352955 (308001)
• A problem that caused the create date/time of a spool file to be erroneously initialized when it was

updated using mfjctlbp has been corrected.

02394543 (351038)
• During a job restart, cataloged datasets that had not yet reached their expiration date were not deleted

properly. These are now deleted without any errors.

02503936 (401156)
• A problem that caused an incorrect return code to be set for an S422 abend when the job card specified

JOBRC=LASTRC has been fixed.

02454664 (392024)
• A new environment variable, ES_IEBGEN_TO_ICEGEN, has been added to enable VSAM copy using

MFGENER.

02469299 (393078)

Mainframe Access

Back to the list

• The MFMON2 command-line utility would throw an exception when it was unable to delete a temporary
file. This has been fixed.

02515298 (411041)
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• The strupr() function was occasionally abending when the text to be folded was in the last allocated
page. This has been fixed.

(468028)
• When downloading job output that had a single or multiple blanks for a record, this could result in the

MFA Server abending. This has been fixed.

(407110)
• Syncmon2 now supports 10 character Panvalet member names.

02301547 (301002)

Micro Focus Batch Scheduler Integration

Back to the list

• Control-M : %%SET expression containing %%BLANK(nn) was causing blank character(s) to be
incorrectly suppressed. This has been fixed.

02476823 (395144)
• An issue in mfbsijcl related to Control-M LIBSYM/GLOBAL has been corrected.

02519366 (405218)
• The handling of a Control-M symbol file (GLOBAL/LIBSYM) containing an incorrect end-of-file delimiter

was incorrect. This has been fixed.

02476611 (393144)
• The mfbsijcl utility has been updated to detect lost connections to redis, and then reconnect.

02319798 02537263 (313011)
• The mfbsijcl and mfbsiemx utilities have been updated to detect lost connections to redis, and then

reconnect.

02537263 (441005)
• In previous versions of Enterprise Developer and Enterprise Server, when the Control-M AutoEdit

functon %%MINUS was used, the numeric result value had the same number of digits as Operand
length.  For example:

       //* %%SET %%MIN3    = 005    
       //* %%SET %%MIN3_R  = %%MIN3 %%MINUS 3

sets MIN3_R to 002.

Starting in this release, you can obtain the a value of 2 for MIN3_R by specifying the %%MINUS=CTM
parameter in mfbsi.cfg. This ensures compatibility with Control-M z/OS.

Note: To stay compatible with previous versions of Enterprise Developer and Enterprise Server, do
not specify the %%MINUS=CTM parameter, or do specify %%MINUS=MF.

02524163 (411121)

Micro Focus Common Client

Back to the list

• The Micro Focus Common Client now adds Accept and Origin headers with default values to HTTP
requests if the invoking program has not set its own values for those headers. This improves
interoperability with some Web services.

Note: This affects COBOL Web service client proxy programs, CICS Web Interface clients, and
CICS Web Services clients.

(104096)
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Micro Focus Cryptographic Library

Back to the list

• The version of OpenSSL provided with the product has been updated to 1.1.1t.

(407184)

Micro Focus Directory Server

Back to the list

• MFDS stopped when supplied with the incorrect mfServer property when updating an enterprise server
region. This has been fixed.

02547102 (442003)
• The casstart /s option incorrectly copied the start-type parameter. This has been fixed

02250159 (244185)
• An issue that sometimes caused MFDS to crash when starting multiple enterprise server regions

simultaneously has been fixed.

02310876 02409262 (286081)
• In ESCWA, modifications have been made to MQ Listeners, JES Initiators, JES Printers, and IMS

MPRs so that they persist across MFDS restarts.

02341059 (297067)
• Micro Focus Directory Server internal session identifiers have been increased in size and complexity to

reduce vulnerability to attack.

02365249 (344004)
• Starting or stopping an enterprise server region using ESCWA or the MFDS UI intermittently terminated

the process. This has been fixed.

(415049)
• Modifying or deleting an enterprise server region's MFRHBINP Request Handler via the ESCWA user

interface or API is no longer allowed.

02525461 (413117)
• Enterprise server region start-up performance was slow when a large number of regions were specified

on a Micro Focus Directory Server with a large number of values stored in the vault facility. This has
been corrected.

(394122)
• If the MFDS process could not access the TCP port it was configured to use, it failed to start and

emitted the error message HS0001S HTTP server failed to initialize, rc=6:
CCITCP-0006E An invalid server or machine name was presented to CCITCP. It now
fails with the message HS0001S HTTP server failed to initialize, rc=57:
CCITCP-0057E Insufficient permission to complete an operation.

(388038)
• If the MFDS process could not access the TCP port it was configured to use, it failed to start and

emitted the error message HS0001S HTTP server failed to initialize, rc=6:
CCITCP-0006E An invalid server or machine name was presented to CCITCP. It now
fails with the message HS0001S HTTP server failed to initialize, rc=57:
CCITCP-0057E Insufficient permission to complete an operation

02433110 (380037)
• Some audit events output when setting the Create Audit Events option for the MFDS process using the

MFDS Web interface were not being output when using ESCWA to change the same configuration. This
has been corrected.

02412285 (365078)
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• MF Directory Server Enterprise Server Administration HTML Web interface was accepting UNC paths
as input values for some import and export operations. This has been fixed.

02423785 (369017)

Micro Focus License Administration

Back to the list

• Micro Focus License Administration now displays the licenses for the same product and serial number
but with a different expiry date on separate lines.

(365148)
• Some libraries have been updated to fix current known vulnerabilities.

(295042) (295068) (309006)
• The SafeNet server list can now be used as expected.

02341760 (259135)

PL/I Support

Back to the list

• A problem with CICS API calls on 64 Bit Solaris has been resolved.

(204210)
• UNSPEC('any-literal') returned an incorrect result when -bitsltr was in effect. This has been

corrected.

02332714 (297013)
• A problem that caused the compiler to abort on a DFT RANGE(*) without attributes has been fixed.

02134010 (198020)
• A problem that occurred when the first operand of the PRECISION built-in was type PICTURE has been

fixed.

02386647 (352016)
• All variable names in evaluations are now rendered in upper case according to the existing style.

(405076)
• A problem that occurred when using a JCL User Exit written in COBOL that called PL/I subroutines

prevented the FINISH condition from being correctly driven when multiple jobstreams ended with STOP
and SIGNAL ERROR. This has been corrected. 

02426916 (371002)
• PL/I triggered a FIXEDOVERFLOW when a FIXED DECIMAL target was assigned for the ADD,

SUBTRACT, or DIVIDE built-in functions that specified an even precision for the optional third
parameter. This behavior did not match mainframe behavior, and has now been fixed. 

02163371 (306065)
• The open and close parenthesis were erroneously included in the start/end column information for a

variable reference when used within and EXEC CICS statement. This has been corrected.

(405098)
• The PL/I macro preprocessor erroneously merged keywords split by a new-line character. This has

been fixed.

02382436 (331016)
• A problem with an incorrect result for the DAYS built-in function with -bifprec 31 on Solaris and AIX

is now fixed.

(338010)

58 | Resolved Issues



• A problem that caused an abort on comma-separated assignments with concatenated string constants
has been fixed.

02040800 (167025)
• A problem that occurred when array of fixed bin unsigned (8) was passed as an argument

to entry has been fixed.

02267392 (259072)
• A limitation with Restricted Expression Evaluation has been resolved.

00368484 (13137)
• A problem calculating the result length of the STRING built-in when applied to non-connected storage

has been fixed.

02514231 (406150)
• An erroneous diagnostic, MFPLI00349E Invalid Defined Overlay, has been corrected when

CHAR type alignment attributes differ.

02522533 (410043)
• A problem that caused the Open PL/I compiler to misdiagnose missing arguments in a CALL statement

when OPTIONS(VARIABLE) was not specified on the ENTRY declaration has been fixed.

02498133 (402105)
• A problem that prevented the PLI EDIT built-in function from working with EDCDIC data has been fixed.

02413874 (364086)
• A problem with a keyword following a string literal with no space between, e.g., dcl y pic'99'def

c;, has been fixed.

(327006)
• The compiler cross-reference (-xref) listing now ensures alignment f line/fileid, nesting, and source

margins in the listing file. 

02159460 (285036)
• A problem with using a function call without parentheses as an array index has been corrected.

02053467 (167108)
• When the ROUND built-in function is given a negative scale factor, MFPLI00554W (now W-level) is

issued and a zero-scale factor is no longer supplied by the compiler. The negative scale produces the
intended result.

02380701 (350017)
• A problem with DEFAULT RANGE (*) BUILTIN overriding previous DEFAULT RANGE (*) type

attributes for non-built-ins has been fixed.

(400017)
• A problem that caused the DB2 ECM to generate little/big endian conversion loops for each element of

an indicator array has been fixed to only convert it once for the entire array.

02373551 (321012)
• The PL/I PLIDUMP report has been extended to support decorated external symbols and variable

names when running under Windows. The variable name, type, and value (if known) are now displayed
for these decorated external types.  Note:  If the external variable is not currently being used or
accessed in the program that generates the PLIDUMP report, its type and value is not identified as that
information is not not present in the program's PDB file. The error message displayed for a variable in
this category has been amended to suggest that this is the issue.

02557839 (441078)
• The QUICKSORT and QUICKSORTX built-in subroutines are now supported.

00368505 (28200)
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• Open PL/1 now supports the MIN and MAX built-ins with array arguments. In addition, the maximum
number to arguments allowed is 64.

02040835 (167026)
• Open-PLI now accepts ENDF as an abbreviation for the ENDFILE condition.

02048350 (167074)
• The following compiler options now imply –nolaxif: -cics, -sql, -dli, -mvs, and -ims 

(402054)
• A problem that occurred when trying to read an ASCII LSEQ dataset using the SYSIN FILE opened with

an explicit OPEN, in a program compiled with -ebcdic, prevented the input records from being
automatically translated to EBCDIC. This has been fixed.

02388783 (346010)
• A problem that stopped the Open PL/I PLISAXA parser from parsing when the

UNKNOWN_CONTENT_REFERENCE event was driven, and which then triggered an EXECEPTION
event with a code of 26 has been corrected.

02552959 (441034)
• When attempting to do a REWRITE of a VSAM record using a BIGENDIAN CHAR VARYING scalar as

the argument to the FROM option, a RECORD condition was sometimes erroneously raised. This has
been corrected.

02544322 (429073)
• An implicit open of a CTLASA dataset targeted as a SYSOUT in the JCL and with a RECFM of V failed

with an UNDEFINEDFILE condition when the implicit open immediately followed an open/close cycle.
This has been fixed.

02503905 (401159)
• A problem that caused an ERROR condition when attempting to do a REWRITE to a fixed-length file

from a CHAR VARYING even though the length of the CHAR VARYING was exactly the same as a the
fixed-length record needed when the program was compiled with -bigendian has been fixed.

(327004)
• The B format specification in a PL/I PICTURE variable was not always honored properly. This has been

corrected.

02397067 (351067)
• An erroneous severe MFPLI00092S diagnostic related to a missing locator has been fixed.

00368488 (415071)
• PL/I BiFs JSONPUTVALUE and JSONPUTMEMBER wrongfully adding structure-member closing tags.

This has been corrected.

02298471 (267008)
• The PL/I JSON built-in function sometimes returned an incorrect number for bytes processed. This has

been fixed.

02491557 (399091)
• The PL/I SUBSTR built-in was producing incorrect results. This has been fixed.

02338555 (297035)
• The PL/I JSONGETVALUE built-in function now correctly parses JSON escape characters.

02399600 (352078)
• The PL/I macro -tagmin option now covers both built-ins and procedures.

02310267 (284005)
• A problem with the PL/I compiler caused it to issue correct diagnostics on an uninstalled license and

when the licensing daemon was stopped. This has been corrected.

02409479 (386043)
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• The PL/I xmlcontent attribute is now supported.

02292363 (260198)
• Diagnostics for the CONTROLLED argument has been improved.

02130963 (195071)
• The incorrect result returned by the LENGTH built-in function when used with the TRIM built-in has

been fixed. For example:

pic1 = LENGTH(TRIM(string1)) ;

Where pic1 is any PICTURED variable, and string1 is any CHAR or CHAR VARYING string.

02291604 (264004)
• A problem that occurred when passing a CHAR(*) VAR BIGENDIAN argument to an ENTRY without

parameter descriptors has been fixed.

02393040 (350031)
• A problem at compile time with evaluating expressions involving the LENGTH and MAXLENGTH built-in

functions has been fixed.

02453457 02453465 02453476 02453510 (385057)
• A problem concatenating based bit strings has been fixed.

02384231 (331026)
• A problem with the HEX built-in when used in conjunction with the two-argument form of the CHAR

built-in has been fixed.

02371250 (314032)
• A message was added to PLIDUMP to print {cond static external} for CONDITION declarations

in the locals section rather than throwing the following errors: 
MFCWD06102E EXTERNAL variable not found in map. MFCWD09121E Invalid type to fetch.

(393106)
• The PL/I documentation has been updated to include the -laxother and -nolaxother compiler

options.

(27357)
• The MFP_RAISEERROR environment variable has been added to enable the direct raising of ERROR

when STRINGRANGE or SUBSCRIPTRANGE would otherwise be triggered. Valid values are
STRINGRANGE;SUBSCRIPTRANGE (for both), STRINGRANGE, and SUBSCRIPTRANGE.

00696776 (368012)
• The FIXEDOVERFLOW condition was sometimes raised erroneously when FIXED DECIMAL division

and dividing 0 by another number This has been resolved.

02430977 (372028)
• A problem that caused memory corruption in PL/I JSONPUTMEMBER() with a value containing double

quotes has been fixed.

02496895 (401074)
• A problem related to STRING pseudo-variable with PICTURED type has been fixed.

02062482 (180008)
• A problem with an IF/ELSE block not behaving as expected when the IF clause was not of type BIT(1)

has been fixed.

02459207 (390029)
• Previously, if an EDIT-directed output was specified with a B() format, an RTS Error 137 would be

generated if the length of the B() format item was less than the length of the underlying variable being
displayed.

02382223 (387115)
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• The documentation for PL/I run-time messages and codes has been updated with new explanations
and error codes.

02423667 (364163)
• The PL/I EXEC preprocessor has been updated to allow comments containing DB2 optimization

guidelines.

02474554 (393114)
• A problem that caused the PL/I macro preprocessor to SIGSEGV on PARMSET evaluation has been

fixed.

02378658 (327002)
• A problem that caused the PL/I EXEC preprocessor to skip % statement parsing has been fixed.

02343270 (301024)
• A PL/I member declaration was missing for DB2 SQL INSERT using arrays. This has been corrected.

02421921 (365182)
• A problem causing a MFPLI00465W: The expression is a duplicate of one found in a

previous WHEN clause warning to be erroneously generated has been fixed.

02425404 (370011)
• A problem with named constants of type BIT resulting in a conversion error during initialization has been

fixed.

02425272 (365219)
• A problem that caused the PL/I macro preprocessor to produce a SIGSEGV on PARMSET evaluation

has been fixed.

02359139 (308041)
• The PL/I COMMENT() built-in function incorrectly handled strings spanning over multiple lines. This has

been fixed.

02490439 (399077)
• A problem that caused the PL/I macro preprocessor to misalign source output has been fixed.

02366044 (306123)
• PL/I nested macro procedure in a built-in now provides correct %SDEBUG and %RDEBUG tags.

02311393 (286018)

REXX Support

Back to the list

• MVSVAR('SYMDEF','SYSTEMA') now returns the value of SYSTEMA if it has been specified in an
IEASYSxx member of SYS1.PARMLIB

02398875 (350090)
• Submitting JCL that runs REXX code that resulted in a fault had the potential to cause the failing REXX

program to become locked in the REXX program cache. This has been fixed.

02387862 (351002)

Run-time System

Back to the list

• The memory associated with a dynamic length item declared in local-storage was not released when
the program instance exited, which led to memory leakage. This has been fixed.

(443004)
• The Run-time System now produces an RTS error if the Profiler attempts to output an .ipf file in a

read-only directory.
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(407092)
• An issue in the native Run-Time System's clean-up logic sometimes resulted in a crash when a .NET

AppDomain running a .NET COBOL program was unloaded. This has now been fixed.

02259505 (301047)
• Previously, in some ES region configurations, enabling CTF tracing for RTS API events could result in

very large CTF trace log files, and cause an ES region to take a very long time to start. This has now
been fixed.

02320601 02497148 (403104)
• Programs using the public SPOOL API - MVSSPLPB - failed when run outside of an enterprise server

region. This is now fixed.

02328509 (291012)
• The event priority of a CTF API entry is set to a default value of 0 when CBL_EXIT_PROC is called with

a function code that does not expect a priority or provides an invalid one.

(380019)
• The LE370 module CEE3DLY will now be found when compiling and running a program on UNIX

platforms.

(375014)
• Printer settings, such as the paper size, etc., selected in the Printer dialog box loaded from

PC_PRINTER_SET_DEFAULT when browsing for a default printer, were not in effect during printing
from native and .NET COBOL programs. This is now fixed.

02260752 (285002)
• Using a DISPLAY statement from a SQL CLR stored procedure sometimes resulted in a

System.NullReferenceException. This is now fixed.

02533532 (415173)
• The validation of the logical printer position in PC_PRINTER_SET_POSITION assumed that paper size/

printable area size properties always matched printer orientation, and therefore sometimes erroneously
reported error 31 (BadPosition) when printing from .NET COBOL programs. This is now fixed.

02478164 (394154)
• Selecting a custom paper size in the Printer dialog box loaded from PC_PRINTER_SET_DEFAULT

when browsing for a default printer sometimes resulted in Run-time System error 9/004 when printing
from .NET COBOL programs running in remote Azure VMs. This is now fixed.

02416340 (365222)
• Selecting a custom paper size in the Printer dialog box loaded from PC_PRINTER_SET_DEFAULT

when browsing for a default printer sometimes resulted in a Run-Time System error 9/004 when printing
from .NET COBOL programs. This is now fixed.

02416340 (365116)
• Publishing a program with an XML GENERATE statement in an SQL stored procedure now works as

expected once the project files are manually edited appropriately.

02508845 (407057)
• When using CBL_THREAD_CREATE_P to create a thread in a .NET COBOL application, the stack-size

parameter was ignored so the created thread always used the default stack size. This has now been
fixed. 

02344128 (296105)
• When printing using printer redirection in .NET COBOL programs, written records are buffered by

default for performance reasons. Previously, this could have resulted in misaligned text if a record
starting with many leading spaces ends up split between different buffers. This has now been fixed.

02260785 (284116)
• Native preprocessors (including COBSQL, HTMLPP, and PREXML) are not currently supported in .NET

6 applications.
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(425003)

SQL: COBSQL

Back to the list

• A problem with COBSQL that prevented it from handling the FETCH and EBCDIC conversion of more
than 100K rows has been fixed.

02236464 (260248)
• COBSQL has ben updated to handle ENTRY statements broken into multiple lines.

02417156 (367003)
• COBSQL has been modified to handle inline comments in EXEC SQL statements when using the

SYBASE precompiler.

(285007)
• COBSQL has been updated for SYBASE such that it no longer inserts a period when an EXEC SQL

statement is coded inside of an IF block. 

01886033 (125015)
• COBSQL has been updated to handle EBCDIC conversion of group variables used in INSERT

statements.

02316688 02316681 (285067)
• The COBSQL precompiler has been updated to correctly convert redefined EBCDIC variables when

present.

02421843 (364169), 02444639 (382084), 02453885 (385123), 02426534 (385109)
• COBSQL has been modified to handle EBCDIC conversion of group variables.

02316681 (288015)
• COBSQL has ben updated to handle inline comments inside DECLARE blocks when Informix is used.

02380790 (348020)
•  The COBSQL preprocessor has been updated to support the ALPHA-LIT-CONT directive.

02544092 (430025)

SQL: HCO for DB2 LUW

Back to the list

• The DB2 ECM now correctly sets the length of the PIC G host variables before CHARSET conversion.

(424053)
• An RTS 114 error sometimes occurred when SQLCODE was set to 0 (zero) and an SQL program built

as 64-bit called either DSNTIAR or DSNTIAC. This has been corrected.

02304281 (393071)
• A problem that caused DB2 database values to return ASCII values in EBCDIC mode when using the

DB2 ECM, the dialect"ENTCOBOL" directive, and a customize character set translation, has been
resolved.

(425023)

SQL: HCO for PostgreSQL

Back to the list

• HCOPG returned unexpected values for TIMESTAMP_ISO statements. This has been corrected.

02513681 (406103)
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• A problem that occurred when using the CURRENT SQLID in SELECT INTO statement with
SQL(DIALECT=MAINFRAME) has been fixed.

02356934 (306026)

SQL: HCO for SQL Server

Back to the list

• HCOSS returned unexpected values for TIMESTAMP_ISO statements. This has been corrected.

02513681 (406103)
• When the DATE and TIME directives were used with HCOSS for PostgreSQL, the incorrect format was

applied to datetime literals. The correct corresponding format is now applied.

(397080)
• OpenESQL has been updated to return SQLWARN4=space with DIALECT=MAINFRAME and

SQLCODE=-811.

02360026 (308064)
• A problem that caused HCOSS to return a space in SQLWARN0 when no other SQLWARN field

contained a W has been fixed.

02397838 (351070)
• A problem compiling a COBOL SQL program with multiple fetch statements using WITH ROWSET

POSITIONING has been fixed.

02340840 (297057)
• A problem with passing numeric or blank values for unsupported parameters to the HCOSS DSN bind

utility caused a DSN syntax error. This has been resolved.

02338931 (296093)
• A problem with inserting a DEFAULT value as the only item in the list of an INSERT statement with

SQL(DIALECT=MAINFRAME) has been fixed.

02354547 (303098)
• When using an EXEC SQL DECLARE host-variable VARIABLE FOR BIT DATA statement you can now

specify multiple host variables as a comma-separated list.  If you use multiple DECLARE host-variable
VARIABLE FOR BIT DATA statements in one EXEC SQL block, a compile error now occurs.

02167287 (203217)
• ErrRow options have been added to the command-line version of the HCOSS Transfer Data tool.

02523081 (410056)
• A problem that sometimes occurred then running the HCOSS mfdatatransferctlr command to

transfer data from DB2 to SQL Server has been fixed.

02473761 (393118)

SQL: Mainframe Batch Database Utilities (MBDT)

Back to the list

• A problem that occurred when loading a data record into a specific partition of a table in DB2 LUW
where the partition column was of the DECIMAL data type has been fixed.

02236304 02391344 (264096)
• A problem outputting a cataloged SYSPRINT in LSEQ  format from SQLTP2 has been fixed.

02493612 (405166)
• MINVALUE and MAXVALUE in the partition definition of a table in DB2 LUW are now supported.

02552457 (442029)
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• A performance issue that occurred when executing a large number of SELECT statements (>2000)
using SQLTP2 has been fixed.

02452507 (387078)
• A problem with tokenizing SELECT and FROM  when they were the last word of a line has been fixed.

02369123 (313049)
• A problem that caused COND Code=004 to be returned when no rows were unloaded by SQLTUL or

DSNTIAUL has been fixed.

02564044 (448064)
• A problem that prevented the full description of SQL Warnings and Errors from appearing in the

SYSPRINT generated by SQLTUL has been fixed.

02368699 (314014)
• A problem that occurred when using empty string '' in the projection list of SELECT statement with

SQLTUL has been fixed.

02333999 (296042)
• A problem with using SQLUTB LOAD to print SYSPRINT for concatenated SYSIN that has multiple

LOAD commands has been fixed.

02457219 (385098)
• A problem with defining DCB with RECFM only for SYSREC when using SQLTUL UNLOAD has been

fixed.

02430243 (394076)
• A problem that occurred when using POSITION(*) and POSITION(*+n) in the field specifications for

SQLUTB LOAD has been fixed.

02355299 02456205 (307056)
• A problem that occasionally caused an ABEND by SYSPRINT, FCD3 STATUS: 9 when executing the

SQLUTB utility to unload/reload DB2 LUW tables multiple times in one JCL job has been fixed.

02432703 (372071)
• A problem unloading data from empty views (or tables) that contained varchar/varbinary columns using

SQKUTB has been fixed.

02500000 (405182)
• A problem loading the implied decimal data into tables with SQLUTB has been fixed.

02361847 (310040)
• A problem with using SQLTUL to unload CLOB and BLOB data into a record with other fields when the

LOGFILE parameter was not specified has been fixed.

02463342 (389044)
• A problem that occurred when setting null values to 0x00 bytes in the unloaded data sets generated by

SQLTUL/DSNTIAUL has been fixed.

02348857 (372004)
• A problem with executing SELECT statements that had a large number of rows with SQLTUL has been

fixed.  

02398804 (363147)
• A problem using a large-size SQL statement (up to 64K) as SYSIN input for SQLTUL has been

corrected.

02335290 02346228 (272013)
• The DEFAULTIF option in DSNUTILB LOAD and SQLUTB LOAD is now supported when the condition

parameter is a character-string.

02456269 (386112)
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SQL: OpenESQL

Back to the list

• A problem that caused erroneous memory usage in the OpenESQL run time has been fixed.

02321779 (293023)
• A problem that prevented parameters in the ADO UNBIND CONNECTION statement from being

replaced has been fixed.

(406004)
• A problem that prevented a temporary table from being created has been fixed.

02494026 (401152)
• HCOSS date expressions missing the date part compiled incorrectly. This has been fixed.

02501717 (407018)
• A problem that prevented HCO for SQL Server and PostgreSQL from applying the expected values

when set statements contained three or more host variables has been fixed.

02506484 (405077)
• The .NET 6 ODBC Nuget package was missing some dependencies. These are now included.

02474422 (395110)
• DSNREXX now handles SQLIND in SQLDA correctly when a NULL record is returned.

02540551 (419034)
• DSNREXX now successfully executes SQL statements larger than 512 bytes.

02442341 (389037)
• The column length of a VARCHAR type column was returned incorrectly when the SQL statement was

being prepared dynamically. This has been corrected.

02503856 (405091)
• A problem that prevented database locks from being released at the end of an DSNALI transaction

when using switch modules that use OpenESQL has been fixed.

02307521 (296031)
• A problem that occurred when specifying the SQL(CLOSE_ON_ROLLBACK=NO) directive caused SQL

Server to automatically close a cursor after a rollback statement has been corrected.  The cursor is now
defined as a fast-forward cursor instead of a fire-hose cursor.

(401104)
• A problem with the ODBC ECM that produced a subscript-out-of-range error when using a host variable

with a leading FILLER item before a data item in an SQL statement has been fixed.

02334866 (312064)
• When run under Enterprise Server with an XA connection, HCOSS stored procedures were being

called without the DIALECT=MAINFRAME directive being set. This has been resolved.

02318095 (286138)
• A problem with using msbuild from a Visual Studio prompt caused build warnings referring to the SQL

native runtime DLL. This has been resolved. The required dependency file was added to the ODBC
SQL Runtime Nuget .NET 6 packages.

02474156 (393120)
• A problem that sometimes occurred when compiling DBCS code in SJIS locale for embedded SQL

applications has been fixed.

02349559 (301080)
• An exception error that occurred when trying to run .NET Core/.NET 6 COBOL SQL applications with

the SQL ODBC runtime Nuget packages with a Windows command prompt has been resolved.

02351590 (306091)
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SQL Option for DB2

Back to the list

• An issue with the XDB ODBC Driver failing to get output arguments returned from a stored procedure
due to the setting of null indicators has been resolved.

02420241 (377058)
• An issue involving nested scalar/aggregate functions operating on a view containing a union of other

queries resulted in query common space being exhausted. This has been resolved.

02434830 (375074)
• An invalid return of X004 Number value overflow has been resolved when using Java to send a

BigDecimal value of zero into a DECIMAL(1,0) value.

02444253 (380071)
• A problem that caused the DB2 TIMESTAMPDIFF function to give incorrect results when setting XDB

Server to DB2 V10 or DB2 V11 has been fixed.

02260541 (253025)
• A server thread violation on a union query containing the RID scalar has been resolved.

(5425)
• The XDB Migrate utility has been enhanced to allow for the substitution of object qualifiers in the

CREATE VIEW source retrieved from the STATEMENT CLOB in a source location SYSIBM.SYSVIEWS
table.

02418490 (365153)
• A problem with COMMIT WORK statements performed dynamically by XTEP2 that caused the

COMMIT query descriptor in the client side communication layer to leak has been fixed.

02310413 (285128)
• Local XDB engines now allow a single expression within an INSERT VALUES clause that is not

surrounded by parentheses.

02333579 (296112)
• The BOPT40N utility now dumps the usage information to standard out when invoked with the -h option.

02346831 (297134)

Visual Studio IDE

Back to the list

• Server Explorer now displays the enterprise server regions if ESCWA was not started as a Windows
service.

02458571 (415100)
• An issue with the Dialog System Painter menu item using an incorrect path location in Visual Studio

2022 has been resolved.

02466323 (395008)
• Using the Micro Focus transport on the Attach to process dialog box now works correctly in Visual

Studio 2022.

(264035)
• The option to debug a core dump from a Mainframe Subsystem project now works for 32-bit core dump

files in Visual Studio 2022.

(441046)
• When the .idy file for a project cannot be found when debugging, Visual Studio no longer accesses

the disk continually in an attempt to find it.

(258033)
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• Visual Studio now passes credentials when enabling a server for dynamic debugging.

(295085)
• Projects using Pro*COBOL can now be built from the command line using MSBuild.

(382060)
• An issue where pressing F5 to launch a Unit Test Project would fail to run any test cases has been

resolved.

(264092)
• Projects that use a mainframe COBOL dialect could fail to set the RTNCODE-SIZE Compiler directive

correctly due to the use of explicit setting or unsetting of the P64 Compiler directive depending on the
project configuration. This has been fixed.

02523704 (410091)
• An issue with the installation of the Visual Studio extensions has been resolved.

02516155 (399062)
• Large data reference counts are now shown correctly in the IDEs.

02130631 (195070)
• The keyword string is no longer highlighted as a verb when it represents a System.String.

(254035)
• Code cleanup can now change the case of keywords in your code. You can specify the preferred case in

the code cleanup preferences, then use the Format Document with Code Cleanup or Format
Selection with Code Cleanup  commands on your code to apply the transformation.

02503932 (403171)
• Previously, the editor would display a data item as grey and not red if it has been previously referenced

32766 times. This limit has been increased to 65533.

02426569 (371012)

XML Support

Back to the list

• The XML runtime now performs better when reading a large XML file.

02526445 (417029)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Defect number (in parentheses).

• (295041)
• 02508043 (407049)
• 02479358 (393153)
• 02504425 (424001)
• 01901711 (127012)
• 02287394 (258209)
• 02558536 (447020)
• 02190101 (363024)
• (381007)
• (384016)
• 02450685 (386098)
• 02423113 (364179)
• 02439474 (382038)
• 02453576 (385060)
• 00373758 (448044)
• 02500115 (406011)
• (402012)
• 02458038 (387132)
• 02544746 (425075)
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Unsupported or Deprecated Functionality
This section includes information about features or functionality that are not supported.

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release - release 10.0. The SafeNet Sentinel licenses will not be supported
after release 9.0. You can only use AutoPass licenses starting with release 10.0.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
However, it is not necessary to switch to AutoPass licenses unless you are adopting release 10.0.
Contact Micro Focus Customer Care for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Additional Software Requirements
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software.

See this information on the Product Documentation pages on Micro Focus Customer Care, in the product
help for Enterprise Developer for Visual Studio 2022 (click here).
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Installation

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM.

The maximum disk space requirements are, approximately:

Enterprise Developer Sentinel RMS License Manager

2.3Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Note:

• A 64-bit Windows is required. You can produce both 32-bit and 64-bit applications with Enterprise
Developer installed on a 64-bit operating system.

Installation | 73

https://sld.microfocus.com/mysoftware/download/downloadcenter
https://sld.microfocus.com/mysoftware/download/downloadcenter


Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio must
be installed in advance.

Besides the software listed below, the setup file also installs the 64-bit AdoptOpenJDK 17.0.4 (LTS) with
Hotspot.

This product includes OpenSSL version 3.0.

• Visual Studio IDE
• Selecting the Visual Studio components to install
• Installing Visual Studio features that are not currently installed
• License Manager requirements
• Other Requirements

Visual Studio IDE

You must have Microsoft's Visual Studio 2022 version 17.4 or a newer one installed in advance.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition - see the next section for the Visual Studio components
you must install.

Microsoft's Visual Studio Express Edition is not supported.

Important:

• When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Enterprise Developer product help inside Visual Studio. When you select
components to install in the Visual Studio installer, click Individual components and check Help
Viewer in the Code tools section.

The following software is also required:

• Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Selecting the Visual Studio components to install

The Visual Studio installer enables you to customize and only install the workloads and components that
are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.

If not already installed, the Enterprise Developer setup file will install the following components:

• .NET Framework version 4.7.2.
• Debugger
• Data services

A number of workloads and components are optional and only required by specific types of applications or
tasks:

• Azure, WCF, Web, WPF, MSVC, or SQL CLR application development.

Important: The latest version of the C++ x64/x86 build tools component, which is part of the MSVC
Workload, is required to generate some IMTK clients.

If you require any of these, you can select them when you start the Visual Studio installer or, enable them
after completing the installation - see the next section.
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Installing Visual Studio features that are not currently installed

If a feature of Visual Studio was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:

Rerun the Visual Studio installer:

1. Start the Visual Studio installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web

development or Help Viewer).
3. Start the Visual Studio installation.

Use the Quick Launch control in Visual Studio:

1. Start Visual Studio.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help

Viewer.

A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.

Use the Install Missing Feature(s) command in Visual Studio:

1. Start Visual Studio.
2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.

Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Micro Focus project template requires a Visual Studio feature which is not currently

installed, the IDE displays an information bar with instructions to install the feature.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Other Requirements

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following package: the Windows SDK package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.
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If you need to use any other version of these packages, or use them installed to a non-default location, use
the cblms command line utility post-installation to manage this; see Managing the Microsoft Build Tools
and Windows SDK Packages for more information.

Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:

• If, when you install Enterprise Developer, the machine does not have Microsoft Visual C++ 2017
Redistributable Runtime already installed, it is installed as required by Enterprise Developer. The
installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital
signatures, into the winsxs directory.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Various actions and operations within your COBOL development environment depend on certain
Microsoft files distributed in the following packages: the Windows SDK package and the Microsoft Build
Tools package. By default, a standard product installation downloads and installs these. Refer to
Microsoft Package Dependencies to see if these packages are required. If you do not plan to use your
development tool in a way that will depend on any of these packages, you can run a non-standard
installation, which will skip their download and installation, thus saving disk space and time taken for
installation. Refer to Advanced Installation Tasks for details on the available installation options.

On UNIX

Hardware Requirements
The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

POWER
running AIX

Micro Focus 1.1 GB 4.40 GB 2.20 GB 41 MB

System Z
running Red
Hat Linux

Micro Focus 630 MB 2.52 GB 1.26 GB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Red Hat for
Docker

Micro Focus 809 MB 3.24 GB 1.62 GB 50 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x64 running
Amazon Linux
2

Micro Focus 804 MB 3.22 GB 1.61 GB 50 MB

Amazon for
Docker

Micro Focus 803 MB 3.21 GB 1.61 GB 50 MB

SPARC
running
Solaris

Micro Focus 877 MB 3.51 GB 1.75 GB 42 MB

System Z
running SUSE
SLES

Micro Focus 585 MB 2.34 GB 1.17 GB 39 MB

x64 running
SUSE SLES

Micro Focus 865 MB 3.46 GB 1.73 GB 50 MB

x64 running
Ubuntu

Micro Focus 834 MB 3.34 GB 1.67 GB 50 MB

SUSE for
Docker

Micro Focus 864 MB 3.46 GB 1.73 GB 50 MB

Ubuntu for
Docker

Micro Focus 864 MB 3.46 GB 1.73 GB 50 MB

x86-64
running Rocky
Linux

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Rocky Linux
for Docker

Micro Focus 809 MB 3.24 GB 1.62 GB 50 MB

x86-64
running
Oracle Linux -
Red Hat
Compatibility
Kernel

Micro Focus 1.17 GB 4.66 GB 2.33 GB 50 MB

Operating Systems Supported
For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements for Micro Focus Enterprise Developer Unix
Components
The following topic lists the software requirements for Micro Focus Enterprise Developer Unix Components.

• Software required by the setup file
• Libraries required by the setup file
• Software required to run the product
• Required environment variables
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• License Manager requirements

Software required by the setup file

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true

Libraries required by the setup file

The following table lists the required libraries for Red Hat and SUSE Linux platforms. The setup file checks
that both the 32-bit and 64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library 32-bit
Librar

y
Name

64-bit
Library
Name

Platform

s390 SUSE
121

SUSE 151 Red Hat 6x Red Hat 7 Red Hat 8

glibc glibc-
*.i686

glibc-
*.x86_64

glibc-
*.s390

X X X

libgcc libgcc
-
*.i686

libgcc-
*.x86_64

libgcc-
*.s390

X X X

libstdc++ libstdc
++-
*.i686

libstdc++-
*.x86_64

libstdc++-
*.s390

X X X

glibc-locale glibc-
locale
-32bit

glibc-
locale-2

X X

glibc-devel glibc-
devel-
*.i686

glibc-
devel-
*.x86_64

glibc-
devel-
*.s390

X X X

elfutils-libelf elfutils
-
libelf.i
386
or
elfutils
-
libelf.i
686

elfutils-
libelf.x86-
64

N/A X X X
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Library 32-bit
Librar

y
Name

64-bit
Library
Name

Platform

s390 SUSE
121

SUSE 151 Red Hat 6x Red Hat 7 Red Hat 8

libelf-devel** elfutils
-
devel.
i386
or
elfutils
-
devel.
i686

elfutils-
devel.x86
-64

N/A X X X

libelf-devel** libelf-
devel-
32bit-
0.137
-8.19

libelf-
devel-0.1
37-8.19

N/A X X X

libelf1** libelf1
-32bit-
0.137
-8.19

libelf1-0.1
37-8.19

N/A X X

gcc2 gcc*.i
686

gcc*x86_
64

X X X X X X

cpp2 cpp*x86_
64

X X X

ld2 Binutil
s*.i68
6

Binutils*x
86_64

X X X X X X

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On SUSE 12 and 15, you can only install the 64-bit version of Enterprise Developer. The glibc-

locale-32bit library is still required by the SafeNet Sentinel licensed components.
• 2On Red Hat, these libraries are required to enable COBOL and PL/I to compile.
• * Additional libraries required to use the core_on_error run-time system variable. The gdb packages (for

the GNU Project Debugger) can be installed from the install media for your OS.
• ** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

Software required to run the product

• Java 1.8 (64-bit) or later is required to run Micro Focus Enterprise Developer Unix Components. The
recommended version is Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot. You can download
Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web site and unpack the archive
anywhere on your machine.

Required environment variables

• To execute JVM COBOL code, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir
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where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the
installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Installation on UNIX and Linux (Known Issues)

Installing on Ubuntu 10.10 and later

Every version of Ubuntu starting with 10.10 comes with a setting that prevents an application from using
ptrace to attach to another process. This prevents the PL/I debugger from attaching to user processes, and
therefore debugging fails. To prevent this problem, disable the offending setting as follows before installing
Enterprise Developer:

1. Using any text editor, open the /proc/sys/kernel/yama/ptrace_scope file.
2. Set pctrace=0.

For more information, see Debugging applications that run on Ubuntu (ptrace restriction).
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Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing
Note:

• This version of the product is a full install.
• See Before Installing first for important information. Also, see Installing as an Upgrade, if you have

an earlier version of Enterprise Developer installed on your machine.

To install this product:

1. Run the edvs2022_90.exe file and follow the wizard instructions to install the prerequisite software
and the product.

The installer installs Enterprise Developer, Enterprise Server for .NET, Micro Focus Analysis Services
Integration, and the Micro Focus Host Access for the Cloud TN3270 emulator. The setup file will also
install any missing prerequisite software as listed in the topic Software Requirements.
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2. If, after installing, there are issues with using the Micro Focus functionality, you might need to execute
the following command from a Visual Studio command prompt:

devenv /updateconfiguration

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features,
and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus Customer Care to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Micro Focus Enterprise Developer Unix
Components
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_9.0_platform

2. Run the installer from the Process User ID login:

./setup_entdev_9.0_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

Enterprise Server System Administrator Process

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server processes
except the one for the Micro Focus Directory Server (MFDS). The Directory Server process (Enterprise
Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

You must supply the user ID at the command line - specify -EsadminID=[ ID ] as part of your
command.
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By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh and follow the
onscreen instructions.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_9.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing and licensing Micro Focus Rumba - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing the Mainframe Components - available in the product Help and on the Product Documentation

pages on Micro Focus Customer Care
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
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See this information on the Product Documentation pages on Micro Focus Customer Care, in the product
help for Enterprise Developer for Visual Studio 2022 (click here).

On Windows

Installing as an Upgrade
• This release cannot be installed as an upgrade to an earlier release of Enterprise Developer. You must

uninstall the previous version before installing 9.0.

Enterprise Developer Installation Options
To install Enterprise Developer you run edvs2022_90.exe which contains a number of product .msi files
(Windows Installer packages). When run, edvs2022_90.exe performs some initial system checks then
sequentially installs the .msi files.

edvs2022_90.exe can take a number of parameters, enabling you to specify a number of different types
of installation:

• Standard Installation

Format:
edvs2022_90.exe

Summary:
Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.

• Non-standard Installation 

Format:
edvs2022_90.exe skipmstools=1

Summary:
Full installation, minus the Microsoft package dependencies. A standard installation downloads and
installs the latest Windows SDK packages. Refer to Microsoft Package Dependencies to see if you
will depend on these packages, and if not, use the option above to skip installation of the packages,
thus reducing the footprint and duration of the installation process.

• Non-interactive Installation

Format:
edvs2022_90.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
start /wait edvs2022_90.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
start /wait edvs2022_90.exe /q InstallFolder=d:\otherdirectory

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:\otherdirectory.
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Format:
start /wait edvs2022_90.exe /q RumbaCheckbox=1

Summary:
Full installation of Enterprise Developer and of the Micro Focus Rumba+ Desktop component. All
components are installed non-interactively with no user interface.

To see what parameters you can use, execute the following from the command line:
edvs2022_90.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

On UNIX

Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Enterprise Developer Unix
Components, so you do not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer Unix Components installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving Product Configuration

The following information applies when you are upgrading from releases 6.0, 7.0, or 8.0.

If you install this release to the same install location as release 6.0, 7.0, or 8.0, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
EnterpriseDeveloper, during the installation process it is moved to /opt/microfocus/
EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/
microfocus/EnterpriseDeveloper. The backup location will store your original installation along with
any files you deployed to that directory. It will also contain any configuration files you modified post-install.

When installing 9.0 the installer moves a number of specific configuration files to a different configuration
location and symbolically links them back to the new release install location. The configuration location will
be one of the following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
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• To specify your own configuration location, run the setup file with the following command-line option: -
mfconfiglocation=[location]

The setup file creates a directory in the configuration location using a 5-digit checksum of the $COBDIR
path. This is so that each configuration location is unique to each product installation. The configuration
files and directories are then placed in this COBDIR checksum directory. In the following example, the
install location generates a checksum of 39082.

The file /opt/microfocus/config/39082/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS, into the
install location after the upgrade installation is complete.

You can access the configuration area from $COBDIR/etc/config.

Currently, the setup file only moves the following files and directories, where applicable:

Source Destination

$COBDIR/etc/mfds /opt/microfocus/config/39082/mfds/mfds

$COBDIR/etc/ccsid /opt/microfocus/config/39082/config/
ccsid

$COBDIR/etc/secrets /opt/microfocus/config/39082/secrets

$COBDIR/bin/mf370ctl.cfg /opt/microfocus/config/39082/config/
mf370ctl.cfg

$COBDIR/bin/CCI.INI /opt/microfocus/config/39082/config/
CCI.INI

$COBDIR/deploy/.mfdeploy /opt/microfocus/config/39082/
deploy/.mfdeploy

$COBDIR/etc/cas/CTFesjcl.cfg /opt/microfocus/config/39082/cas/
CTFesjcl.cfg

$COBDIR/etc/cas/dfhdrdat /opt/microfocus/config/39082/cas/
dfhdrdat

$COBDIR/etc/commonwebadmin.json /opt/microfocus/config/39082/escwa/
commonwebadmin.json

$COBDIR/etc/mfdsacfg.xml /opt/microfocus/config/39082/mfds/
mfdsacfg.xml

$COBDIR/etc/mfdsacfg.dat /opt/microfocus/config/39082/mfds/
mfdsacfg.dat

$COBDIR/etc/mf-client.dat /opt/microfocus/config/39082/mfds/mf-
client.dat

$COBDIR/etc/mf-server.dat /opt/microfocus/config/39082/mfds/mf-
server.dat

$COBDIR/etc/cobol.dir /opt/microfocus/config/39082/config/
cobol.dir

$COBDIR/etc/cobopt /opt/microfocus/config/39082/config/
cobopt
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Source Destination

$COBDIR/etc/cobopt64 /opt/microfocus/config/39082/config/
cobopt64

$COBDIR/etc/cobjvm.cfg /opt/microfocus/config/39082/config/
cobjvm.cfg

$COBDIR/etc/cobutf8.cfg /opt/microfocus/config/39082/config/
cobutf8.cfg

$COBDIR/etc/default.tcf /opt/microfocus/config/39082/config/
default.tcf

$COBDIR/etc/mfescache.cfg /opt/microfocus/config/39082/config/
mfescache.cfg

$COBDIR/etc/dsdef.cfg /opt/microfocus/config/39082/config/
dsdef.cfg

Micro Focus Enterprise Developer Unix Components Installation
Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_9.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.
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You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

Installing using the TMPDIR environment variable

By default, the product installer uses /tmp for temporary files and log files during installation. If /tmp is not
available on your system you can set the environment variable TMPDIR to an alternative location:

TMPDIR=/home/user/tmp
Export TMPDIR

Then run the installation as normal.

Note:

The TMPDIR setting is lost when the installer is elevated to root user within the installer. This occurs
when you run the installer as a non-root user, and are prompted for the root password during the
installation process. Micro Focus recommends that you log in as root, set TMPDIR and then run the
installer. If you use sudo to run the installer, then use the following command-line syntax:

sudo TMPDIR=$TMPDIR setup…

or:

sudo TMPDIR=/home/user/tmp setup…

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any documentation updates.

On Windows

Starting the Product
You are now ready to run Enterprise Developer:

Windows 10 • From your Windows desktop, click Start > Visual Studio 2022.

Windows 11 • Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start Visual Studio 2022.

Managing the Microsoft Build Tools and Windows SDK Packages
There are a number of COBOL development features that depend on the Microsoft Build Tools and
Windows SDK packages. By default, the product installer downloads and installs these packages to their
default locations. The installer then sets your COBOL environment to depend on those downloaded
versions.

You can use the Microsoft Build Tools and Windows SDK Packages configuration utility - cblms - to view
which versions are in use, and also configure your COBOL environment if you require something other
than the standard usage.
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For example, some project types (for example, .NET projects) require a different version of the Microsoft
Build Tools (the Visual Studio 2019 version) than the one installed (the Visual Studio 2017 version). If you
have already installed the correct version for .NET, run cblms after product installation, to update your
environment to use the correct package.

There is an option within the product installer to skip the installation of the default packages
(skipmstools=1); however, this does skip both packages, so make sure that you do already have the
package(s) that you require before setting this - see Microsoft Package Dependencies for details on the
package(s) you may require.

The Microsoft Build Tools and Windows SDK Configuration Utility

Use the cblms command line utility to view and set the package versions in effect for your COBOL environment.

Important: If you are updating or clearing package versions, you must run this utility from a command
prompt with administrative privileges.

Syntax:
cblms <option>

Parameters:

Note: <option> settings are case insensitive.

<option> can be one of:

-U
Updates the COBOL environment to use the latest versions of the Microsoft Build Tools
and SDK packages that are located in the default folders. Any open IDE instance or
command prompt must be restarted before these changes take effect.

-U<ms-pkg>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the default folder. Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the default folder.Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<path>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-U<ms-pkg>:<path>?<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-L
Lists all versions of the Microsoft Build Tools and SDK packages that are located in the
default folders.

-L<ms-pkg>
Lists all versions of a particular package type that are located in the default folder.

-L<ms-pkg>:<path>
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Lists all versions of a particular package type that are located in the (non-default) folder
specified.

-Q
Displays the versions currently in use by the COBOL environment.

-Q<ms-pkg>
Displays the version of the selected package type that is currently in use by the COBOL
environment.

-R
Clears all version information. (Only use this option when instructed to by Customer Care.)

-H
Displays the available command line options.

Legend:

<ms-pkg> <ms-pkg> can be one of S or SDK for the Microsoft SDK, or B or BT for the Microsoft Build
Tools.

<path> <path> is the path in which to locate packages that are not installed to the default location for
their package type.

<version> <version> is the package version with which to update when the latest version is not the one
required. When specifying version, it must be in the form:

• n.n.n.n for a Windows SDK
• n.n.n for Build Tools
• n for list ID - the list ID is displayed using cblms -L.

The following example updates the COBOL environment to use version 10.0.17134.0 of
the Windows 10 SDK, installed in C:\WinSDK\10.

cblms -USDK:C:\WinSDK\10\10.0.17134.0

Viewing the Product Help
Enterprise Developer is configured to display the product help available online on the Micro Focus
Customer Care website: https://www.microfocus.com/support-and-services/documentation/.

You can view the product help in one of the following ways:

Online help (default)

Note:

• Your Visual Studio must be configured to show online help by default. Make sure Help > Set Help
Preferences in Visual Studio points to Launch in Browser.

• Ensure that you have an up-to-date version of your browser.

You can access the Help in one of the following ways:

• Click Help > Micro Focus Product Help > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens the Enterprise Developer help or Microsoft's MSDN depending on which keyword in the
editor or part of the UI you are querying.
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Local help

Note: If you've had an earlier version of Enterprise Developer installed on your machine, you need to
uninstall any older version of the documentation as follows:

1. Click Help > Add and Remove Content inside Visual Studio.

This starts the Microsoft Help Viewer.
2. Click the Manage Content tab and click Disk.
3. Click Remove next to the line for the Enterprise Developer documentation.
4. Click Update.

The local help is not shipped with the installer. If you prefer to view the help locally on your machine, you
need to download and install it manually as described below.

1. Download the local help files:

a. Find the download link for local help in your Electronic Product Download email or in the Product
Updates section on the Micro Focus Customer Care website and save the files on your machine.

b. Expand the archive on your machine. Ensure that the .msha and the .cab files are in the same
folder.

2. Ensure that the Visual Studio Help Viewer is installed:

a. Click Help inside Visual Studio.

If no View Help command is available, you need to install the Help Viewer manually. See Installing
missing components of Visual Studio in Software Requirements for instructions on how to install it.

3. Install the help in the Help Viewer:

a. Click Help > Add and Remove Content inside Visual Studio.

This starts the Microsoft Help Viewer.
b. Click the Manage Content tab and click Disk.
c. Click the browse button next to Disk and navigate to the folder in which you extracted the local help

files.
d. Select helpcontentsetup.msha and click Open.

This loads the Enterprise Developer documentation.
e. Click Add and then Update.

After the installation is complete, the Enterprise Developer product Help appears in the Help Viewer.
4. Configure Visual Studio to use local help:

a. Start Visual Studio.
b. Ensure that the Visual Studio Help Library is pointing to local help - from the Visual Studio menu

click Help > Set Help Preferences > Launch in Help Viewer.
c. Click Help > View Help.

This opens the product help in Microsoft's Help Viewer.

For full details of the Visual Studio Help system, see the MSDN.

Note: On some Windows versions, an issue with Microsoft Help Viewer and Internet Explorer's
security being turned on can cause the Help content to be displayed as raw HTML code. To
resolve the issue, you need to turn off the Internet Explorer Enhanced Security Configuration
(IE ESC) for both administrators and users. Check the Microsoft Windows help for more
information on how to do this.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
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Important: Before performing a repair of the installation, Micro Focus recommends that you create
backups of any configuration files of the product that you might have changed.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, Micro Focus Analysis Services Integration, and Micro Focus License Administration.
Uninstalling only Enterprise Developer does not automatically uninstall Enterprise Server for .NET,
the Micro Focus License Administration or any of the prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.
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Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper9.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus Customer Care.

Important: The SafeNet Sentinel licensing system has been deprecated and will be not available in
this product starting with the next major release - release 10.0.

The SafeNet Sentinel licenses will not be supported after release 9.0. You can only use AutoPass
licenses from release 10.0.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
However, it is not necessary to switch to AutoPass licenses unless you are adopting release 10.0.
Contact Micro Focus Customer Care for further information.

To start Micro Focus License Administration

To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing

2. Type cesadmintool.bat, and press Enter.

Installing licenses
You need either a license file (with a .mflic extension for Sentinel RMS licenses or an .xml extension for
AutoPass licenses) or an authorization code which consists of a string of 16 alphanumeric characters
(Sentinel RMS licenses only). You need to install AutoPass licenses into the existing Micro Focus License
Administration tool, and not in the AutoPass License Server.

If you have a license file

To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
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3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic or .xml).

• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.

If you have not installed a license for Enterprise Developer, trying to use the Micro Focus functionality
for the first time after you install the product results in a warning message. Visual Studio displays an
information bar with a message that Enterprise Developer does not have a valid license. You can use
the Install license link in the bar, or close the bar.

2. Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog
box.

3. Click Browse next to the License file field.
4. Select the license file (which has an extension of either .mflic or .xml), and then click Open.
5. Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

If you have an authorization code
Note: Authorization codes are only available with Sentinel RMS licensing.

Authorizing your product when you have an Internet connection
Note:

• This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
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To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. On the Install tab, click Manual Authorization.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the Customer Care Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus Customer Care Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

To use the command-line Micro Focus License Administration tool

In order to authorize your product from the command-line Micro Focus License Administration tool you
must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
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7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus Customer Care.
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Updates and Customer Care
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Customer Care
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the Customer Care Web site, including demos and additional

product documentation. Go to https://supportline.microfocus.com/examplesandutilities/index.aspx.
• The Support Resources section of the Customer Care Web site, that includes troubleshooting guides

and information about how to raise an incident. Go to https://supportline.microfocus.com/
supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Portal.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site for Micro Focus products, https://www.microfocus.com/support-and-services/contact-support/. If you
obtained the product from another source, such as an authorized distributor, contact them for help first. If
they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your Micro Focus product. See Micro Focus
Channel on YouTube.

• Micro Focus webinars: https://www.microfocus.com/en-us/resource-center/webinar.

Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with Customer Care, you should
collect some basic information before you contact us, and be ready to share it when you do.
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See the Preparing to Raise a Support Case topic on the Product Documentation pages on Customer Care,
in the product help for Enterprise Developer for Visual Studio 2022 (click here).

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus Customer
Care, your support representative might request that you provide additional debug files (as well as source
and data files) to help us determine the cause of the problem. If so, they will advise you how to create
them.
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Copyright and Disclaimer
© Copyright 2023 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.

100 | Copyright and Disclaimer


	Contents
	Micro Focus Enterprise Developer 9.0 for Visual Studio Release Notes
	What's New
	Learn Micro Focus™ COBOL Extension for Visual Studio Code and Micro Focus™ COBOL Fundamentals Course
	Micro Focus™ Enterprise Extension for Visual Studio Code
	Micro Focus™ COBOL Extension for Visual Studio Code
	.NET Support
	COBOL Language
	Compiler Directives
	Data Modernization Advice
	Debugging
	Enterprise Server
	Enterprise Server Common Web Administration (ESCWA)
	Enterprise Server Security
	HCO for SQL Server
	HCO for PostgreSQL
	IMS Support
	Interface Mapping Toolkit
	JCL Support
	Mainframe Access
	Micro Focus Unit Testing Framework
	OpenESQL
	PL/I
	Terminal Emulation
	Tracing
	Visual Studio

	Significant Changes in Behavior or Usage
	Known Issues
	Resolved Issues
	Other Issues Resolved in This Release
	Unsupported or Deprecated Functionality
	Additional Software Requirements
	Installation
	Before Installing
	Downloading the Product
	On Windows
	System Requirements
	Hardware Requirements
	Operating Systems Supported
	Software Requirements

	Product Co-Existence
	Installation Restrictions and Requirements

	On UNIX
	Hardware Requirements
	Operating Systems Supported
	Software Requirements for Micro Focus Enterprise Developer Unix Components
	Installation on UNIX and Linux (Known Issues)


	Basic Installation
	Installing
	Installing Micro Focus Enterprise Developer Unix Components

	Advanced Installation Tasks
	On Windows
	Installing as an Upgrade
	Enterprise Developer Installation Options

	On UNIX
	Installing as an Upgrade
	Micro Focus Enterprise Developer Unix Components Installation Options


	After Installing
	On Windows
	Starting the Product
	Managing the Microsoft Build Tools and Windows SDK Packages
	The Microsoft Build Tools and Windows SDK Configuration Utility

	Viewing the Product Help
	Repairing
	Uninstalling

	On UNIX
	Repairing on UNIX
	Uninstalling



	Licensing Information
	To start Micro Focus License Administration
	Installing licenses
	If you have a license file
	If you have an authorization code
	Authorizing your product when you have an Internet connection
	Authorizing your product when you don't have an Internet connection


	To obtain more licenses

	Updates and Customer Care
	Further Information and Customer Care
	Information We Need
	Creating Debug Files

	Copyright and Disclaimer

